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Preface

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme
Any last-minute information about Agile PLM can be found in the Readme file on the Oracle

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Getting Started in Agile CNM

This chapter includes the following:

= Welcome to Agile Customer Needs Management............ccccvveuenrcreinicreisies s snse s 1
B What's NEW N CNM 1.2, sttt 2
5 LOGGING N0 CNM ...t 2

Welcome to Agile Customer Needs Management

Agile Customer Needs Management (CNM) helps you transform market requirements into products.
CNM offers a platform on which Product and Project owners can capture, filter, refine, collaborate
on, prioritize, and eventually incorporate market requirements into products. Those requirements
can originate from such sources as CRM, Quality, or other enterprise applications, as well as
detailed documents received from customers, and so forth.

How to Find Documentation for CNM

The Oracle Agile documentation set is found at this Web site:
http://www.oracle.com/technetwork/documentation/agile-085940.html.

The manuals that document Agile CNM in this product release are:
@ CNM Readme

o CNM Implementation Guide (including Installation)

o CNM User and Administration Guide

@ CNM Web Services Guide

o CNM Security Guide

Installation Test Notice

Install and test this release on a designated Development server before installing it on your
Production environment. Your Development environment should mirror your Production
environment as closely as possible to provide accurate testing results.

It is important to validate the installation of this release, and to confirm your integrations are working
correctly as part of your due diligence. Any problems or questions noted during your Development
system testing should be resolved before installing this release on your Production environment.

vi.2 1
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What's New in CNM 1.2

The following improvements were added to CNM 1.2.

m]

CNM Integration with PQM and PCM: CNM is now integrated with two more Agile PLM solutions,
Product Quality Management and Product Cost Management. In support of this, Problem
Reports (PQM) and Prices (PCM) can now be added to References.

Integration of CNM with Product Collaboration and Product Portfolio Management was already
established: Iltems (PC) and Projects (PPM) can be added to References.

For more information about the integration of Agile CNM with Agile PC, PPM, PCM, and PQM,
see Integration of CNM with other Agile PLM Solutions on page 34.

Promotion: Also supporting integration of CNM with PLM solutions, CNM business objects, such
as Requirements, can be promoted to the product record as Documents. For more information,
see Promoting CNM Objects to Agile Product Record (on page 26).

Customer and Product Line: Two fields have been added to the Object Details page in CNM
objects: Customer and Product Line. They are enabled with AutoComplete feature (also called
TypeAhead), where the system prompts from existing values of the attribute and you choose
from the offered list. (Tags were enabled with AutoComplete in previous CNM.)

Web Services in CNM: Web Services have been added; these are documented in CNM Web
Services Guide.

Cluster: The CNM solution can now be set up in a clustered environment; this is documented in
CNM Implementation Guide.

Logging in to CNM

Before you can log in to CNM, your user account needs to be created and enabled in Agile PLM
Administrator for the Agile Application Server that CNM is authenticating against. For more
information, see the CNM Implementation Guide.

First, be sure to disable the popup blocker for CNM-related URLSs in the browser you are using.

Agile Product Lifecycle Management
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Enter the determined URL for the CNM application. The Login page appears.

ORACLE Agile Customer Needs Management

Login

Enter your uzername and password.

Username:

Password:

Enter your username and password and click @. You are brought to the Home page of the
CNM application.

v1.2 3






Chapter 2
Exploring the Home Page

This chapter includes the following:

B OVEIVIEW OF HOME PAGE ..ottt st bbb n s 5
= Areas 0N the HOME PAGE ..o 6
= MenuS ON the LEft TOOIDAI..........ccciirricesieseer ettt 10
= Menus on the RIGNt TOOIDAN ... 12

SEArCHING IN CNM......ooieicct ettt et bbbt bbb s bbbttt s st bbb s tans 13

Overview of Home Page

When you log in to CNM, the Home page appears. You can accomplish many tasks from the CNM
Home page. Here is a list of such tasks.

o View any outstanding reviews requested from you in the My Pending Reviews area.

o Read the latest information about objects in the Recent Updates area.

o Review a graphical representation of the current status of objects from the Records By Status
dashboard area.

= View the tags, or categories, given to objects to locate a grouping of specific objects from the
Tag Cloud.

o Create objects using the Create button.

= Access bookmarked objects using the Favorites menu.

o Go to recently visited objects using the Recents menu.

o Access the Tools menu.

@ Search for an individual object in CNM using Search or Browse.
o Access to system configuration using the Administration link.

= Change your display using the User Preferences link.

= Access clarification about CNM behavior from the Help link.

@ End your current user session from the Logout link.

Multi-tab View

On the CNM Home page, neither the Home nor Browse tabs can be closed. They are always available
for access no matter how many other CNM objects are also open (with their own tab).

The Browse tab presents the Advanced Search page, where you can perform a Quick search or an
Advanced search. Executing any search returns results to the Browse tab. If the Browse tab already

vi.2 5
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contains executed search results, the older search results are replaced by the newer ones.
Searches are detailed in Searching in CNM on page 13.

ORACLE Agile Customer Needs Management

Home

= Records By Status

= By Type Ildea VI

Recent Updates

Q IDEADDOZS: beers (Last Modified today)
* Modified by Azita Kamangar yesterday : Tags was

Q IDEADOS03: new object 1030 (Last Modified today)
* Modified by Azita Kamangar today : Detailz content updated;
* Modified by Azita Kamangar yesterday : Tags was <null= iz <test=;

Q IDEADDO24: drinks (Last Modified today)
* Modified by Azita Kamangar today : Detailz content updated;
W Approved A8 lAA Approved W Fer

Q IDEAQZ2333: Chinese characters 2M1/11 (Last Modified yesterday) M Rejected 1 In Progress Wint
* Modified by Jody Wu yesterday : Description was <null> iz <tests; I Iﬁe-.-ie-r.' | M Canceled M App
* Created by Jody Wu yesterday npregress in .
= Tags

Q IDEAD2332: 22 (Last Modified yesterday)

Multiple tabs are displayed as objects are opened, or if the Administration area is accessed. Each
opened object is under the latest tab at the end of the tab-row.

The maximum number of open, visible tabs is ten. Once a user reaches that limit, a notifications
prompts to close a tab in order to open another tab.

If a user selects an object that is already an active and open tab, the page focus for the user is
changed to the already available tab.

Areas on the Home Page

The following sections illustrate how to navigate through each component that is accessible from
the Home page.

Note The Home page areas — Recent Updates, My Pending Reviews, Records By Status,
Tags — do not refresh with recent changes until you log out and log back in to CNM.

Recent Updates

The Recent Updates area displays a list of summaries about what has happened to certain objects
since you logged out of the system. The updates go back a maximum of 30 days (if you logged out
of CNM more than thirty days ago).

Recent updates applies to "tier-one" and "tier-two" objects. A maximum of five updates are
displayed for any object. CNM finds at least ten object updates to display, and displays no more
than 20 objects.

6 Agile Product Lifecycle Management
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This is a sample of a populated Recent Updates area.

Recent Updates

QUOTEOO116: Sports Arena (Last modified today)

*  Component removed by Mariah Thomas today: Remowve Component: Food

* Component added by Mariah Thomas today: Add Component
* Component added by Mariah Thomas today: Add Component
* Component added by Mariah Thomas today: Add Component
* Modified by Mariah Thomas today: Tags was <= iz <ideamt=

IDEAOD34T: Soccer (Last modified todav)
* Created by Mariah Thomas today

IDEAOD335: Baseball (Last modified today)
* Modified by Mariah Thomas today: Tags was <= iz <ideaMT>
* Created by Mariah Thomas today

IDEAO0334: Basketball (Last modified today)
* Modified by Mariah Thomas today: Tags was <= iz <ideaMT>
* Created by Mariah Thomas today

IDEAOD3I3S5: Football (Last modified today)
* Modified by Mariah Thomas today: Tags was <= iz <ideamt=
* Created by Mariah Thomas today

IDEAOOIIT: Volleyball (Last modified today)
* Modified by Mariah Thomas today: Tags was <= iz <ideamt=
* Created by Mariah Thomas today

RECQ01313: Sports (Last modified today)
* Modified by Mariah Thomas today: Tags was <= iz <regmt=

: Food
. Retail
- Sports

* Component added by Mariah Thomas today: Add Component: Soccer

* Component added by Mariah Thomas today: Add Component: Hockey
* Component added by Mariah Thomas today: Add Component: Basketball
* Component added by Mariah Thomas today: Add Component: Football

Object information is displayed for objects that you created, and for objects that you are a team
member. The summaries begin with the most recent event. Each object-name heading is an active

link

My Pending Reviews

When you are assigned as a reviewer for any number of objects, they display as a list in reverse
chronological order in the My Pending Reviews section.

vi.2
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My Pending Reviews

|ﬁ REQO0014: Improve battery life

./ PODOTE: Mew Camera Concepts

REQUESTED DY Admin LMK on UDrlaiZl

. PODOTT: Camera - Baseling 1

REQUERISD DY AT LM on UZiled s

The object IDs are active links that direct you back to the object so you can carry out your review for
that specific object. If the user has no current assignments, this section does not display for the
user.

For more information about review assignments, see Object Signoffs on page 44.

Records By Status

The Records By Status area has a graphical display, or dashboard, of CNM objects filtered by type,
and sorted by their current status. The dashboard provides an at-a-glance view of the proportion of
objects in each CNM status.

Note  Records By Status displays the number of records that were updated by the previous
night. Clicking on the "pie" produces the currently updated number of records.

8 Agile Product Lifecycle Management
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=l Records By Status

M Spproved ll Pending [l Rejected [l Review

When you click a region of the "pie", the system runs a search for all objects of the selected type
that are currently in that status. The results are returned to the Browse tab. You can then select an
object from the results and go directly to its Summary section.

The search has the same constraints as any other search in CNM: the results returned to you
include only those objects that you can see in the Search Results table. For more information about
searches, see Searching in CNM on page 13.

Tag Cloud

Tags are a utility that categorize and group objects. All users with a Participant role or higher can
add and remove tags.

Multiple tags can be associated with one object (comma-separated). The stored tags are displayed
in alphabetical order and lowercase (even if entered in uppercase).

To eliminate repeated or similar tags, CNM prompts existing tags as suggestions to a user who is
associating new tags with an object.

To add atag to an object:

From the Summary section of the object click 4 .

2. The object is now in Edit mode. Enter text in the Tags field or select from the autogenerated
tags. Each tag must be separated by a comma.

av

3. Click =2 1o finish.

v1.2 9
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The Tag Cloud shows all tags that are associated with objects in CNM. CNM tallies and ranks tags,
and displays them in three styles:

o Tags in the top 10% of use are in a large, bold font.
o Tags in the next 30% are in the large font, but not bold.

= The remaining 60% of tags are in a smaller font.

=] Tags

aeg cnm fusion great Iidea

All tags in the Tag Cloud are active links. When you click a tag link, CNM retrieves all objects that are
associated with that tag. The results display in a Search Results table in the Browse tab, as seen in
the sample:

=l Search Result

- [ 5 B

%y z% Al Al | 2
MName Number Tag Status Type Date Created
\_*Single-lens refl . |POO01E camera Review Product 12M15/2010 09:58:0...
'ﬁ'Spy HD camera! |IDEAQ00043 camera,battery Pending ldeal 12M %2010 09.58:0...
'ﬁ'Vuice activated... |IDEANDD4E camera In Progress DD ldeat 12M15/2010 09:58:5...
QA tiny HD camera|IDEADOOET camera In Progress ldeal 12M %2010 10:00:5...
\_Camera - Bazeli._.|POOOTT camera,photograp... |Approved Product 12152010 11:57:4.
QA tiny HD camera|IDEADDTT3 camera In Progress ldeal 12M 2010 11.57:4...
'ﬁ"\fﬂice activated... |IDEADD1T4 camera Review ldeat 121502010 11:57:4.
'ﬁ'Spy HD camera! |IDEA00TS camera Review ldeal 12M 2010 11.57:4...

The search executed by clicking a tag has the same constraints as any other search in CNM: the
results returned to you include only those objects that you can see in the Search Results table. For
more information about searches, see Searching in CNM on page 13.

If you click a tag link and no rows are returned in the Search Results table, it simply reflects that you
are not a team member on any objects associated with that tag. Contact the project manager or
CNM administrator if you want additional access to CNM objects.

10 Agile Product Lifecycle Management
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Menus on the Left Toolbar

The next subsections describe the menus found on the toolbar in the upper left of the CNM Home
page.

Create

A user with a Participant role level or higher can create a new object by clicking the Create button.
To learn more about creating an object, see Creating an Object.

Favorites

The Favorites option provides a way to organize your selection of favorites through the Manage
Favorites... option. There is also a list of any object type you added as a Favorite link. To learn more
about working with Favorites, see Using Favorites on page 21.

Recents

The Recents dropdown menu contains a list of the last ten objects that you opened; each is shown
with an icon of the Type and several characters of the object's name. If you hover over an object in
the list, a tooltip displays its number. As you create new objects, they are added to the Recents list of
objects.

When you select an object in the list, you are taken directly to that object's Summary section. When
an object is opened, it is added to the top of the list of Recents, and the last item in the list is
removed.

Recentzs -

ldea_4
Req_3
Quote_3
ldea_3
Req_2
Req_1
Quote 2
Quote_1
ldea_2
ldea _1

BB<]B R

< i«

If you open an object that is already present in the Recents list, it is simply moved to the top.

The content of the Recents dropdown list is specific to your activities and is carried across user
sessions. For example, an object that is added to a parent object's structure (which is on your
Recents) is not added to your Recents list until you open the child object itself.
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Tools

The Tools dropdown menu has the following two options:
o Import
o View Deleted Objects List

Import

CNM's Import feature supports the following operations:
o Import to update existing objects in the system (CNM server) in the Microsoft Excel format;
o Create objects by using the Import process to import directly from Microsoft Excel worksheets;

o Used in conjunction with export to mass update multiple objects in a hierarchy structure.

For more information about the Import operation, please see Exporting and Importing Objects on
page 59.

View Deleted Objects List

The Deleted Objects List displays all the objects that were deleted by CNM users. The information is
in a table format that can be sorted by any of the column headers. The list is maintained by CNM
and cannot be altered or removed by any user.

To view the Deleted Objects List:
1. Click the Tools dropdown menu.
2. Select View Deleted Objects List. The Deleted Objects List window appears.

3. The columns — Type, Number, Name, Date Deleted, and Deleted By — can be reordered, and made
visible or not visible by using the View dropdown.

4. Click | %% 't finish.

Menus on the Right Toolbar

The next subsections describe the menus on the toolbar to the upper left of the CNM Home page
(above the Search fields).

User Preferences

A CNM user can access some personal user interface settings from User Preferences.

Uzer Preferences

Any changes made to the User Preferences will not take effect until you log out of CNM and log
back in for another user session.

12 Agile Product Lifecycle Management
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User Preferences [ |

Number Format | g7 654,321.08 =]

Language |Engiish |

Time Zone | (GMT+00:00) Greenwich Mean Time : Dublin, Edinburgh, Lisbon, London = |

Time Format Ihh:mm:ss aaa z (10:00:00 AN P5T) j

Date Format  [{EEere.

Help Save Cancel

CNM is available for localization with the following languages: English, French, German, Japanese,
Korean, Russian, Simplified Chinese and Traditional Chinese. These are the available values from
the Language dropdown.

Help

To access Oracle's Agile Product Lifecycle Management Customer Needs Management help

materials, in the top right corner of CNM click Hele_| A window launches where you are directed

to the configured online help materials, or possibly to an Agile PLM User Productivity Kit (UPK)
menu. UPK is a pre-built set of topics that guide you through specific actions in CNM.

Your CNM administrator needs to have previously configured an Online Help URL setting in System
Settings in order for this to be an active link. For more information, see Establishing System Settings.

Logout

To end your user session, click in the top right corner of the CNM application. You will be
immediately directed back to the Login page with the Username and Password fields blank.

Important A user session that is idle for 25 minutes will automatically end the user session.
When you attempt to perform any action, you are directed back to the Login page.
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Searching in CNM

There are two Search utilities:
@ Quick Search fields are at top and right of the Home page.

o Advanced Search fields are under the Browse tab.

Welcome Neal Smith | Adminiztration = . Help | Logout -

Quick Search

Quick Search permits a search through All CNM objects or through one of the three CNM object
types.

Requirement

Refine the Quick Search with a text-string in the field to the right.
Click the Execute Quick Search @ button, or simply hit Enter on your keyboard.

Executing a Quick Search initiates a search of these kinds of fields: Text, Multi-text, Flex, and List
fields in CNM objects.

Specifically, the search returns matching results found in such fields as Name, Number,
Description, Customer, Product Line, Tags, Rich Text, Notes, Comments, Attachment Name, and
Attachment Description.

Note If you experience difficulty obtaining search results, see your CNM Administrator. There
is an administrative "system setting" for Search in Attachment that must be set to Yes.
For more information, see Establishing System Settings.
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Advanced Search

You can set up an Advanced Search under the Browse tab. The Advanced Search section offers
additional criteria to refine search queries.

ORACLE Agile Customer Need< Management Welcome Admin CHM | Administration | User Preferen

Create Favorites Recents Tools Search u

Home Browse

ElAdvanced Search
Match & ANC Any

Type IEquaIs ;II LI Customer IEquaIs LI
MName/Mumber/Desc IW Product Line IEquaIs ;I
Name ICuntains j Rich Text ICuntﬂins ;I
Description ICuntains j Date Created Im I'_?_EB
Humber [Contains =] Date Modified [Equals 7] Y
Tag IEquaIs j Created By IW
[=l Search Result
e |8 5 B
All - All
Name Number Type Description Status Tag Customer Product Line »

o data to dizplay.

4| |

Select the criteria for each field, whether you want your search operator to be Equal to, Does not
Contain, and so on. Then type in the search string you want.

Available wildcards are asterisk (*) or percent-mark (%), which can be placed before, within, and
after the text-string. (Note that CNM internally adds a wildcard character before and after all search
text strings.)

For the Date Created and Date Modified fields, select your search operator to be "On" or "After",

"Before", and so forth, but not "Equal To". Then click Select Date e and choose the date you require
for an accurate search result.

Click | =%3T" | {0 execute your advanced search.
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Note  For the Date Created/Date Modified criteria, the time stamp used is 0:0:0.

If the search criteria you entered returns results that are not what you need, click Reset | o clear
all the fields and enter new criteria.

Search Results

The results of both Quick and Advanced searches are displayed in a table format.

=l Search Result

View » |§ + ||@

All - All

MName Number Type Tag Status De=cription
\_*Single-lens refl.. |POO01E Product camera Review A zingle-lens refle...
"Q"Spy HD camera! |IDEADO043 ldea camera Pending

'@'Vuice activated... | IDEAQQ04E ldea camera,battery In Progress If a camera could h...
QA tiny HD camera|IDEADODSET ldea camera In Progrezs There seems to be ...
\._*Camera - Baseli...|POOOTT Product camera,phetograp... |Approved Bazeling of Camer...
QA tiny HD camera|IDEADDTT3 ldea camera In Progress There zeems to be ...
'ﬁ'Vuice activated... |IDEADD1T4 ldea camera Review If a camera could h...
'ﬁ'Spy HD camera! |IDEA00TS ldea camera Review

@ Conwvert the em... [REQODOSS Requirement camera Approved Ewven mobile phone...
QA tiny HD camera|IDEADOZ0E ldea camera In Progress There seems to be ...

The Search Results table lets you view essential data about a set of objects, such as the status or
who created the objects, and select the result that best matches your query.

The Name and Number columns have active links that take you directly from the Search Results table
to the object you click. You can sort all the columns in a descending or ascending order and also
rearrange the order of the columns displayed.

Search results for CNM objects are contingent upon the team assignments of objects. If you are a
member of the team for an object — either as an individual or as a member of a user group added as
team members — the object displays in the search results. If you are not a team member, even if an
object matches your search criteria, it does not display in the search results.

Note Search results are limited to 5000 entries.

Query by Example

The column headers have Text and List input fields where you can enter text strings to refine your
search results. Clicking the Query By Example button activates and deactivates these text input fields
above the column headers. After entering in the text you want, click Enter on your keyboard.
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Exporting Search Results

o
You can export your entire search results, or selected results, when you click & in the Search
Results window. For more information, see Export from Search Results.

Resetting Search Filters

You can clear the entered text strings from the column header filter boxes by clicking the Reset Filter
button. This lets you enter a different search filter that is applied to the original, unfiltered results.
Once the user clicks Enter, the results refresh with the new results.

Copy to Clipboard

From any search results in CNM, a user can right-click a row or cell and access a Copy function.
This copies the currently selected object (not cell) to an internal CNM clipboard. Then navigate to a
structure of an object in the Explorer area and paste the copied object as an addition to the structure.

View

Tables have a View utility to change the column layout. From the Columns option, you can select
Show All or you can select specific columns to display. Each column header name has a checkmark
next to it if it is displaying. Click the column name from the Columns list options to de-select that
column; the table reloads without that column.

From View, you can also select Reorder Columns... and the Reorder Columns window appears:

[Reorder Columns [%] |

Visible Columns
[Irev

[w] Status

O Type

4P M

01,9 Cancel

The available columns are displayed with a checkbox next to each. Check the box of the column(s)
you want to reorder and then choose to move the item(s) to the top of the list or to move the item(s)

up one position in the list. When you are finished, click 0K and the table shifts column positions to
what you selected.
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Note  The Add Reference window does not allow moving the first column Number out of its default
order.

Table Column Drag and Drop

To illustrate the drag and drop column behavior available in tables, see the example below.

Open an object that has child objects, such as QuoteX. Click B and the page is redirected to the
Structure Table View where you can select a column to rearrange, such as Object Number.

'@'Tyw Dezcription Tagz | Object Number tatus Date Created |Date Modified

Name L Type Description Tags |Object Number |Status Date Created |Date Modified
@Type Deszcription Tags |Object Number |Status Date Created |Date Modified

B £ QuoteXx Quote Thiz iz nesded. QUOTEDDDSS  (Pending |2010-02-24 .. |2010-02-24 .
@Raq'l Requirement |This iz wonderful |fusion |REQO1256 Review |2010-02-24 ... |2010-02-24 ...

=] @Raqa Reguirement |This is awesome |fusion |REQ01294 Approved|2010-02-24 .. [2010-02-24 ...
"‘:l"ldeac idea cnm  |IDEAQDZ5S Pending |2010-02-24 ... |2010-02-24 ...
'@"Il:leall idea cnm  |IDEADO300 Pending |2010-02-24 ... |2010-02-24 ..

ER&qY Requirement |This iz perfect fusion |REQO1252 Review |2010-02-24 .. |2010-02-24 ..

Drag the Object Number column away from its present order.

'@'Tyw Dezcription Tags Status Date Created |Date Modified
Name L Type Description Tags Status Date Created |Date Modified
T
Object Mumber

@Type Dezcription Tags I3 Date Created |Date Modified
B roustex Cll_mte This is needed. Ohject Mumber ing  [2010-02-24 ... [2010-02-24 ...
i Reqt Reguirement |This is wonderful |fusion W (2010-02-24 | 2010-02-24
= [EReqs Requirement | This is aweseme  |fusion Ohject Mumber - droved|2010-02-24 ... |2010-02-24 ...
"C"Il:leaﬂ ldea cnm cUOTENNNGS  Jping | 2010-02-24 . (2010-02-24
Qridead |idea cnm REQOIZOE  JHing |2010-02-24 . |2010-02-24 .
EiReqy Reguirement |Thisis perfect  |fusion | | REonizae  few  [2010-02-24 . [2010-02-24

IDEADN233

IDE&ADOZ00

REGO1 282

Find the column placement you want for Object Number and release the column into the blank
column space.
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"l:f'Type Description Tags |Status | Date Created Datg Modified
Hame DType Description Tags |Status Date Created tE Modified
Ohiject Mumber
ETyp-B Description Tags |Status Date Created te Modified
Ohiject Mumkb
B > Quotex aliote This is nesded. Pending |2010-02-24 . JECLBUMREE. bh o2 24
[ Reqt Requirement |This iz wonderful |fusion |Review |2010-02-24 ., QUOTEODOSE -02-24 ..
= [ Reqb Requirement |This is awesome |fusion |Approved|2010-02-24 | REG01236 D-02-24 ...
QideaC  |idea com  |Pending |2010-02-24 .|| REGD1Z34 -02-24 ...
Uideal [idea cnm  |Pending |2010-02-24 . IDEADDZ53 D-02-24 ...
EReqy Requirement |This iz perfect fusion |Review [2010-02-24 . IDEAD0300 -02-24 ..
REGO1292
W —

The Object Number column is now moved to a new location and order in the Structure Table View.

't:f'Type Description Tags |Status  |Date Created |Object Mumber |Date Modified

Name DType Description Tags |Status Date Created |Cbject Number |Date Modified
@Type Dezcription Tags |Status Date Created |Object Mumber | Date Modified

= Dauntex Quote Thiz iz needed. Pending |2010-02-24 ... |[QUOTEODOSE | 2010-02-24 ...
@ Reqgl Reguirement |This is wonderful |fusion |Review |2010-02-24 .. |REQIM285 2010-02-24 ..

= E RegB Reguirement |This is awesome |fusion |Approved|2010-02-24 . |REQ01254 2010-02-24 .
"C"H:Ieac idea cnm  |Pending |2010-02-24 ... |IDEADDZSS 2010-02-24 ...
"Q"H:Ieatl idea cnm |Pending |2010-02-24 ... |IDEADO3O0 2010-02-24 ..

E Reqt Requirement | This is perfect fusion |Review |2010-02-24 .. |REQ01252 2010-02-24 ...
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Chapter 3
Working with CNM Objects

This chapter includes the following:

Managing ObJECE TEAMS..........ccuiiieiicriiie et ettt b s s bbb a bbb st n et s nnis 40
Managing ObJECE SIGNOFS.........cuiuriiiiriee bbb 44

# ACCESSING CNM ODJECES .....uvviecvciicte ettt bbb bbb ettt n s 21
= Creating and MOdifying ODJECES..........euiuriiiriieircr e 25
= Capabilities 0N "MOre ACHONS" MENU..........criuiuriuririiiiriieinee e 26
5 MaNAGING REFEIENCES.........u et 34
= Fulfilled Attachments and REfEIENCES ..o s 37
5 Managing AtAChMENTS ........ciiie ettt es 38

Accessing CNM Objects

There are numerous ways that you can access a business object in CNM. The list below is followed
by sections about the most versatile methods of "accessing" — for example, the Explorer area is the
main working space for building CNM Structures.

o Recent Updates — from the display of object activity, click the link to the object you want to view
o Favorites — from the list of your added favorites, choose the specific object you want to view

o Recents — from the list of the last ten objects that you have accessed, choose the object you
want to view

= Tag Cloud — from this area, click the tag you want to run a search for all objects that have that
specific tag associated with them and then click the object you want to view

o Search — from the search field, execute a search for an object with specific criteria and
parameters and then click the object you want to view

o Explorer — from the displayed structure of an object and its child objects, click the child object
you want to view

= Where Used — from the Where Used table, click the parent object link to view the object

Favorites

If there are objects that you need to return to frequently, using Favorites helps you find them easily.
The Favorites dropdown menu stores a list of the objects you added as favorites. Any object type
can be added to your Favorites list; the object icon and name are visible in the dropdown menu of
Favorites. The list of favorites is specific to the user.

Once you select an object from your list of favorites, you are directed to the Summary section of that
object. If you no longer have the necessary role to access this object, or if this object is deleted, you
will receive an error message.
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Adding Favorites

The Add to Favorites option is available to you from the More Actions menu. Once you select Add to
Favorites, the object currently open is added to the list of objects under Favorites.

Managing Favorites

The Manage Favorites... option is available from the Favorites dropdown menu to delete previously
added objects as favorites.

To delete an object from the user's Favorites list:

Manage Favorites. ..
1. From the Favorites dropdown menu, click

The Manage Favorites window appears.

3. Click the row of the object you want to delete.

4. Click X to delete the entry from the list.

5. Click 2% |t finish.

Summary

The Summary section of an object displays these fields:
©  Name

o Description

o Status

o More Details (see below)

o Edit
More Details

When the More Details section of an object is expanded, you can view additional attribute information
pertaining to your currently selected object such as Tags, Date Created, Created By, and so on. All of
the flex, or custom, attributes enabled for the object type by the administrator are displayed.
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Rich Text

The Rich Text attribute for objects presents a way for users to enhance the content quality. Users
can enter or paste formatted text in the Rich Text field. When pasting content, any hyperlinks are
automatically opened in a new window when they are selected by a user.

Details
[Font g weae |Eol a Fael F
BJIU| S g8 === &% |22

The text content of the Rich Text field is indexed for searching in CNM, just like the contents of any
other text field.

The Rich Text field is available as one of the fields in Advanced Search when it is enabled. The set
of filters for this field are the same as that for any text field.

However, the Rich Text field is not displayed as a column in search results and cannot use the Query
By Example functionality.

When exporting an object to XML, the formatted content of the Rich Text field (rendered in the form
of HTML) is exported. Rich Text is not exported to Excel.

The Rich Text attribute is a hidden attribute by default. For users to have access, the administrator
must enable the Visible property. For more information, see Object Attributes on page 75.

Notes and Comments

There is a Notes section of objects that allows notes and comments to be added. All users can post
a note or comment.

As notes and comments are posted, they are displayed in reverse chronological order with the most
recent seen on top.

The content of each comment is displayed below the note it is connected with, but is indented.

With each note or comment, the name of the user and the time that he/she added the comment is
logged.

To add a note to an object:

1. From the Notes section click "i' .

2. Inthe Add Note window enter your text into the required Note field.

3. Click 2K to finish.
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To add a comment to a note:
1. Go to the Notes section of an object.
2. Find the note you want to add a comment to and click 3=

3. Inthe Add Comment window, enter your text into the required Comment field.

4. Click 9K tofinish.

Only a user with the Administrator role can delete notes or comments. If you have Administrator
access, a Delete link is available at the end of each note or comment.

To delete a note or comment from an object:
1. From the Notes section, click the expand icon EI.

2. Navigate to the note or comment you wish to delete and click T=t! |

3. You are then asked, "Do you want to delete the selected note/comment?"

4. Click 9% to confirm and finish.

Leveraging the See Also...

CNM objects have a See Also... section that helps users see correlation between objects in the CNM
system.

El 5ee Also..,

(84%)'Q- camera
(61%)QF- A tiny HD camera
(57% Q- SLR Lens

The display shows a percentage, an object type icon, and an active link of the object name. Each
object has a set of object keywords, which are generated using the algorithm described in the
Keyword Generation on page 83 section.

Using an object's keywords, CNM finds similarities with other objects in the system and associates
these objects together for the user in the See Also... section.

The percentage of similarity is calculated between the objects within CNM. Only the top five
associations are included in the See Also... section.
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Note If you are not a team member of an object, the object still displays in the See Also...

section, but you cannot navigate to it.

If a user modifies an object in such a way that content used for keyword association changes, the
See Also... section only refreshes once the object is saved. For more information about keywords,
see Keyword Library on page 83.

Creating and Modifying Objects

There are several places to create an object in CNM.

m]

u]

u]

u]

Home Page — procedure below
Save As on page 29

Explorer on page 49

Import on page 65

To create a new object from the Home page:

1.
2.

Click Il The Create dialog appears.

Select a Type of the new object from the Type dropdown menu.

The Number field generates a Type-specific autonumber.

Enter a name in the Name field (that does not exceed 128 characters).

You have the option to enter a description (that does not exceed 4000 characters) in the
Description field.

When finished click Create. A tab opens with the new object in Edit mode.

In Edit mode, you can enter values for the listed attributes.

a. You can click Cancel without filling new attributes in, the object remains open in uneditable
mode; or, if you fill in some attributes and click Cancel, the entered values are removed and
the object remains open.

b. When you are finished entering values for attributes, click Save; the new values are saved,
and the object remains open in uneditable mode.

c. Click the Edit icon to change the object to editable mode.

Note  The creator of an object is always added to the Team list. If the object type has a

configured default value for team, that default value is also added to the Team list. For
more information see, Managing Object Teams on page 40.
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Modifying Object Attribute Details

After creating the initial object, you will add more data and fields to the object using the Edit mode;
see the task below.

"Customer" and "Product Line" have been added to the Object Details page in CNM objects. They
are enabled with AutoComplete feature (also called TypeAhead), where the system prompts from

existing values of the attribute, and you can choose from the offered list or continue typing. (Tags

are also enabled with AutoComplete, from previous release of CNM.)

To modify attributes of an object:

1. Open an object.

2. Inthe Summary section click 4 .
3. The Summary and More Details sections expand and editable attribute fields are now in Edit
mode.
. . . Save ..
4. Enter new values of attribute fields and then click to finish.

Capabilities on "More Actions" Menu

The More Actions dropdown menu is at top right of any object. Each capability from More Actions is
covered in the following sections.

o Add to Favorites

o Promote

= Save As
o Delete

@ Send

& Export

= History

8 Where Used

Add to Favorites

The Add to Favorites option is available to you from the More Actions menu. Once you select Add to
Favorites the object currently open is added to the list of objects under Favorites.
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Promote CNM Objects to Agile Product Record

You can promote object data from the CNM framework — single CNM objects or multiple-level
Structures — to the product record as Documents.

While it is possible to promote Ideas and Quotes, the Promote feature is intended for the use case
of Requirements deemed ready for creation of the actual product within the Agile PLM suite of
solutions.

Note  The "out-of-box" defaults permit only Requirements to be promoted. To promote Ideas
and Quotes, the CNM administrator must enable the Allow Promote attribute of that CNM
class.

When earlier work such as ideation and pricing has been accomplished, and a Requirement has
been created, modified, and matured, it may be evaluated as ready for material development and
production. This is the time to promote the Requirement to the product record as a Document.

Business Rules of Promoting
The "product record" refers to specific Agile PLM solutions and their primary business objects. The

PLM installed Object Types are detailed in Integration of CNM with other Agile PLM Solutions on
page 34.

References are an important component of the CNM—PLM integration, and provide connections
between promoted CNM objects and referenced PLM objects. This process succeeds by, before
promotion, adding a reference to a CNM object, so be sure to also consult Managing References on
page 34.

This section proceeds with details about the Promote feature.

Important If the Documents class in Agile PLM has not been set up for Autonumbering, CNM
does not promote object data to Document objects.

Privileges Required to Promote CNM Objects

All successful promotions of CNM objects begin with the CNM class being set for Allow Promote, as
well as Autonumbering enabled for Documents.

To promote a CNM object to a PLM Document, you must be assigned the Create privilege in Agile
PLM for the Documents class, which covers all objects created in any Document subclass, or for
the specific Document subclass to which you will be promoting CNM objects.

To promote an object with attached files or URLs, you must be assigned the Get File privilege and
Modify privilege in Agile PLM for the attachments.

To promote an object with references, you must be assigned the Modify privilege on that
Object.Relationship.Name. If you do not have this privilege, you will not able to promote the specific
reference.

When you promote a structure, and you want to see the new BOM structure in the PLM object, the
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BOM tab for that object's subclass must be set to visible for you.
If you have any difficulty with these tasks or actions, see your PLM administrator.
Document BOM

When you promote a Structure (a hierarchy of related CNM objects that might include Ideas,
Quotes, and Requirements), the system creates a Document for each child object in the structure
and maintains the hierarchy. That is, each child document is associated in the BOM tab of the parent
Document in the same order and level.

For convenience, this grouping can be called Bill of Documents or Document BOM.
References and Attachments on Promoted Objects

Before a CNM object is promoted to a PLM solution, you must add a reference to a business object
in Agile PLM. Otherwise, when you promote the CNM object, you will simply create a Document in

PLM but it will not be linked to anything in a PLM solution. (There is nothing wrong with this: you or
another PLM user may link the new document to other business objects in PLM, which is nearly the
same result. However, you may not be able to trace back to the CNM object of origin.)

Here are the rules that govern references and attachments going in the direction of Promotion (from
CNM to PLM):

o Before promoting, if any references to PLM objects are added to the CNM object, its references
are carried at the time of promotion to the Relationships tab of the new Document. The new
document object is therefore connected to the PLM object with a live link.

Note  To promote an object with references, you must be assigned the Modify privilege on
that Object.Relationship.Name. If you do not have this privilege, you will not able to
promote the specific reference.

o Before promoting a CNM object, if any attachments are added, the attachments are carried at
the time of promotion to the Attachments tab of the new Document.

= If there are multiple attachments and/or URLs on the CNM object, they are all included in a
single File Folder that is found on the Attachments tab of the new Document.

Constraint to Promote an Object Once

A CNM object can be promoted to the product record once. The "promote once" constraint is meant
to keep the "ideation” function of CNM discrete from the "productizing” function of other PLM
solutions. A Requirement, for example, should be promoted to the product record only when it has
matured and is truly ready for the development process.

When an object has been promoted, it continues to be modifiable in CNM; however, the More >
Promote sequence for that object is grayed out.

Since it would be counter-productive to continue working in that CNM object (if further work would
be desirable in the product record), the workaround is to use "SaveAs" to create a new CNM object
that, in due time, could be promoted.
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Save As

The option to Save As is enabled only for users with a Participant role or higher. Save As creates a
new object of the same object type, but with a new object number. All of the object attributes are
copied over to the newly created object including tags, Rich text content and attachments.
References, notes, comments, team, and history are not copied over to the newly created object.
To create an object using Save As:

1. Open an object.

. . Save Az
2. Go to the More Actions menu and click

3. Inthe Save As window enter text into the Name field and any desired content into the Description
field.

4. To add a team to the object, there are two methods:

* Type in usernames or user group names. CNM uses the AutoComplete feature to prompt
you with existing user or user group names, from which you can select or continue typing.

Add...

®* Click . In the Add Team window, search for a user or user group.

5. Enter the criteria for your search in the text field and click @.
6. From the search results select the member(s) you want and click .5
7. Inthe Save As window click 2% to finish.

If you do not select any team members to add to your newly created object, CNM automatically
adds you, the creator, as the default team member. Any other team members that you want on the
object need to be specially selected during the Save As process.

Users can access a hyperlink to navigate to either the source or target object of a Save As
operation within the History table. Clicking the hyperlink opens a new tab with the object content.
For more information, see History.

Replicating Structure with Save As

In the Save As dialog, an essential component for objects with child objects is the Replicate structure
checkbox.
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Save As 2]
Mumber IDEAD2330
Type Mdea
* Name
Description
Team Add
7 Replicate structure
Help Save Cancel

"Replicate structure" is checked by default for any object being created from an original template
object that contains an existing structure of child objects. If you uncheck the box, CNM creates an
object with the set criteria but with no child objects associated.

The Replicate-structure function performs the same Save As process for each child object of the
parent object; it maintains the hierarchy levels and dependencies already existent on the original
template object.

To illustrate this behavior, see the example below.
Create an object QuoteX with a child object ReqY, which also has a child object IdeaZ.
B < QuoteX

=l | Reqy

Next, perform a Save As for the parent idea object QuoteX and leave the Replicate structure
checkbox selected. Rename the quote as QuoteA. The structure of that quote is now shown in the
Explorer area as this:

B ' Quotes
= £ ReqgY
@ ldeaz

The result is a new object hierarchy that has a structure identical to the original object’s, but is
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composed of entirely new objects. If you open the ReqY and the IdeaZ objects on the QuoteA
structure, those objects have the same attributes as the originals, but have new object IDs.

Deleting an Object

Deleting an object permanently removes the object from CNM. There is no ability to restore deleted
objects. However, if an object is currently associated with an object structure, either as a parent or
child object, it cannot be deleted. Also, if an object has an attachment or reference, you cannot
delete the object.

To delete an object:

1. Open an object.

) Delete
Go to the More Actions menu and click

3. You are asked, "You are about to delete the current object. Once the object is deleted, it
cannot be recovered. Do you want to continue?"

4. Click %€ to confirm and finish.

Sending an Object

Users in CNM can send objects to one another if the mail server is configured properly in
Administration. For more information, see Establishing System Settings.

The Send operation initiates a notification emalil, to be sent to a user, that provides information
about that object and any comments the user includes while sending the object.

This utility is an excellent way to initiate collaboration surrounding objects and their various
changes. If you perform any actions to an object and want other users to know about it, you can
send the object with the pertinent information within the Notes section.

To send an object:

1. Open an object.

2. Go to the More Actions menu and click Send...

3. In the Send Object window, click Sl

the Recipient field.

to search for a user(s) or user group(s) to include in

Multiple users or user groups are separated by a semicolon (;).

As you type in usernames or user group names, CNM prompts you with existing user names to
select.

Kk Send

4. Enter any desired text in to the Notes field and clic to finish.
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If any of the recipients are not already part of the team of the object being sent, you are prompted at
that time to add them to the team of the object. Recipients who are not added to the team still
receive notifications, but cannot access the object.
The notification provides this information:

* Name and email of who sent the object notification;

* List of all the recipients;

*  Subject of the notification, which includes the object type and object number;

* Body of the message with additional details;

* Notes entered by the user sending the object;

* An active link directing you to the application Login page and then to the open object.

Export

CNM's Export feature supports the following operation:

o Export an individual object, or an object with structure from object structures to a Microsoft
Excel or aXML file

= Export from search results to a Microsoft Excel file

For detailed information about the Export operation, see the chapter on Exporting and Importing
Objects on page 59.

History

The History of an object records the following actions or events:

= Add Attachment = Create Comment = Modify Reference = Remove URL

o Add Component o Create Note = Promote o Request For Review
o Add Reference o Delete Comment o Reject o Reset Signoff

o Add Team Member | = Delete Note = Remove Attachment o Save As (see note

o Add URL o Delete Object o Remove Component below this table)

= Approve = Export = Remove Reference = Send

o Create o Modify o Remove Team Member | = Signoff

Note  The Save As action creates a hyperlink on the source object's History to the destination
object, and similarly creates a hyperlink on the destination object's History to the source
object.
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The History log contains the following fields.

History
view | | acton [ZAHNRG_—_——_]
Action Modified By Detailz Date Modified

*  View — to adjust the column layout

®  Action — a dropdown list of actions, from the list found above, used as a filter for the History
log

* Action — the action performed by a user to the object

® Modified By — username of the user who performed the action

* Details — the action taken along with the affected areas of the object

* Date Modified — the date and time of the action

Note By default, all History logs are sorted by Date Modified in a descending order, having the
most recent activity at the top.

To access the History information of an object:

1. Open an object.

Go to the More Actions menu and click History

3. The History window appears and has a table displaying details about the past actions and
events regarding the currently open object.

4. You can then sort the results by column headers, use View or filter using the Action dropdown.
5. When finished click | ©°%% |

For an object created by a Save As action, the History window has a hyperlink directing the user
back to the original object. Conversely, an object that was used for a Save As action has a hyperlink
within its History window directing the user to the newly created object.

Where Used

To access the Where Used information about an object:

1. Open an object.

- : Where Used
Go to the More Actions menu and click ihere Use

In the Where Used window, a table displays the object that is the parent of the currently open
object.

4. The Name and Number are active links, which take you directly to that parent object's Summary
page.
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Note  Like the search results restrictions, if you do not have access to an object because you
are not a team member, the object does not appear in the Where Used table.

Managing References

A reference is an index link to a record or data that is present in an external system or different
application than CNM. References on reference-enabled objects enrich CNM data with data of
existing product designs or projects.

This section provides information about references from CNM to the integrated Agile PLM solutions.
If you want to establish references to external applications other than Agile PLM, see the chapter on
Exporting and Importing Objects on page 59.

Integration of CNM with other Agile PLM Solutions

In an earlier section, we saw how CNM business objects can be promoted to the product record.
The Promote feature is enhanced by the use of References, which sets a link between a CNM
object and an object in these Agile PLM solutions: Product Collaboration (PC), Product Portfolio
Management (PPM), Product Cost Management (PCM), and Product Quality Management (PQM).

References between CNM and PLM solutions also provide "backward traceability”, that is, links
from objects in Agile PC, PPM, PQM, or PCM back to the CNM objects (such as Requirements) that
led to those products or projects.

When a reference is added in CNM, a link to the referred PLM object is added to the Attachments
and References section (see task below). At the same time, a link to the CNM object is created on
the "referenced" PLM object's Attachments tab (or, in PPM, the Content tab) in the Filename column.

To summarize, there are two ways in which Agile CNM is integrated with Agile PLM solutions:

1. References from CNM to PLM, which adds reference records to CNM objects and links in PLM
object back to CNM object.

2. Promotion of CNM objects to Documents in PLM. Together with References, the new
Documents bring CNM data into the product record.

User authentication must be set up in the Agile PLM system in order for the CNM Add Reference
option to be available in the PLM object's Attachments.

Important If Sites are enabled in Agile PLM, for a CNM user to be able to add a reference to a
PLM-based business object, the user must have access to the Site that is associated
with that object. If Sites are not associated to Agile PLM solutions, this rule does not
obtain.

See your administrator if you are having any difficulty accessing or adding a reference to an object
in the PLM solutions.
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Installed Object Types for PLM Solutions Integrated with CNM

As stated above, References and the Promote feature are the main avenues to integration between
CNM and other PLM solutions.

This table gathers the names of the installed object types (that is, Base classes and their child
Classes and Subclasses) that you may encounter in your work from CNM to PLM. It is a summary
guide, and it assumes you have some familiarity with the PLM hierarchy of how the object types
work. For example, we may say "CNM is integrated with PPM" or "create a reference in CNM to a
PPM Project" — and then you are faced with an object called a "Gate"; the table can remind you why
this is so.

Remember, every business object in PLM is actually a single instance of a particular, named
subclass. Furthermore, the default subclasses can be both renamed and created by the PLM
administrator. For that matter, classes and base classes can also be renamed by the administrator.
You must bear this in mind when you are looking for specific objects in Agile PLM.

PLM Solutions Base Classes Classes available Default Subclasses
integrated with CNM pertinent to CNM to CNM available to CNM
. Parts Part
Product Collaboration (PC) ltems
Documents Document
. . Activities Phase, Program, Project, Task
Product Portfolio Mgt. (PPM) | Projects _
Gates Gate, Milestone
, Product Service Problem Reports Problem Report
Product Quality Mgt. (PQM
y Mgt ( ) Requests (PSRs) (not NCRs)
. Quote Histories Quote History
Product Cost Mgt. (PCM) Prices . . . .
Published Prices Published Price, Contract

Viewing References

To view an object's reference:

1. Go to the Attachments & References section of an object and click the active link of the reference
name.

You are brought to the native application of the reference.

3. The application directs you to the Cover Page of the reference object.

Adding References

To add a reference to an object:

1. Go to the Attachments & References section of an object and click P .

' Ref
2. From the list menu choose "ty Reference

vi.2 35




Customer Needs Management User and Administration Guide

3. Inthe Add Reference window select the object type of Items or Projects, enter your search text
string, and click @ .

4. You can then drag your desired reference item from the Search Results table to the Attachments &
References section, or select the item in the Search Results table and click 2% to finish.

The Add Reference window, mentioned above, allows you to search for an item or project and see the
results in a table format to select the desired reference.

Note The results are limited to 1000 entries.

Add Reference (%]
@
Search Results
View v ‘
Number Description Status Type Rev
(F009-001-X055  |This is an important part. Preliminary  |Part
(& 008-001-X155 Prefiminary | Part
[ 334-1008-02 Production  |Part i}
Do00SS This iz an impertant document Prefiminary | Decument
@1 550 Production  |Part i
@m_ss50 Production  |Part 01
A roooss Preliminary | Diode
@lron1ss Prefiminary | Assembly
alronzss Thig iz an impertant part. Preliminary  |Part
Total Rows 9
Help 0K Cloze

You can expand the search result assemblies to display the first level of BOM Items and add either
an Assembly or any first-level BOM Item as your desired reference.

The displayed attributes of Items (Parts) or Projects within the search results is dependent on the
settings for those attributes in PLM Administrator.

If an attribute is enabled for the BOM table (on Parts), the search results in CNM display the

attribute.

Note  Privileges in Agile PLM are required to support creation of References. For more
information, see Integration of CNM with other Agile PLM Solutions on page 34.
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From the Add Reference window search results, you can drag and drop items from the table into the
Attachments & References section to add the object as a reference. The ability to drag and drop
references includes not only the currently open object, but also any object that is displayed in the
open Explorer structure.

For more information on dragging and dropping within an Explorer structure, see Rearranging an
Object Structure on page 52.

If you add a reference that is already on an object, CNM overwrites the existing reference and
moves that reference to the top of the list. The action of adding references to objects in CNM also
produces a cross-reference for that reference object in its native application. The kinds of cross-
references are detailed in Integration of CNM with other Agile PLM Solutions on page 34.

Removing References

To remove a reference from an object:

1. Go to the Attachments & References section of an object and click X .

2. You are then prompted in a Confirmation window, "Confirm deletion of the Reference:
<reference_number>."

3. Click “K to confirm and finish.

The action of removing references from a CNM object also removes the cross-reference for the
reference object in its native application.

Note If the reference object's business rules (concerning, for example, its Roles, Privileges,
Lifecycles, Workflows) do not allow the cross-reference to be removed, the server does
not remove the cross-reference from the PLM object; the cross-reference link is only
removed from the CNM Attachments & References table.

Fulfilled Attachments and References

Attachments and References have a checkmark icon to indicate if that particular attachment or
reference fulfills a requirement outlined by the object or project. The blue checkmark indicates that
the attachment or reference fulfills the requirement. By clicking the icon a second time, the
checkmark is deactivated and the icon turns gray.

o

If a file attachment is replaced by a file that has the same filename, the current status of the fulfilled
checkmark remains the same.

When a user performs a Save As operation from an object with attachments or references in a
particular state of fulfilment, the current state is transferred to the new object for those attachments
and references.

Once an attachment's or reference's fulfillment-status indicator is modified (checked/unchecked),
that attachment or reference is immediately moved to the top of the Attachments and References table.
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Managing Attachments

Important In order for Agile PLM and Agile CNM integration to work for the Attachments and
References, a user must deploy the agile-cnm-plugin.jar file to the Agile PLM server.
Please refer to the CNM Implementation Guide for details.

There is an Attachments & References section for all objects. If your administrator has selected Agile
PLM as the file server, then Agile PLM is also used for user authentication. If the administrator has
selected UCM as the file server, then LDAP or Agile PLM are used for user authentication.

A user with a Participant role or higher can add, view, or remove attachments and references. A
user with the Viewer role can only download or view attachment files, URLs or References.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper File Folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

Viewing Attachments

Once attachments are added to an object, they are displayed in reverse chronological order with the
most recent being found at the top of the list. Once the object has an attachment in the Attachments
& References section, the following information is displayed:

o Attachment type icon

@ Viewicon

= Fulfilled Checkmark

= Delete option

o Attachment Name

o Attachment Description

o File size

o First Name and Last Name of the user that added the attachment

o Date and Time the attachment was added

[= Aftachments & References

C=] #& nhttp:iwoww bestinformation.c... Mariah Thomas 0202011 09:02:07 PN GNMT
"] # Po00OOS test Mariah Thomas 02/05/2011 05:01:35 PM GMT
&a 3 TOC1.bmp Thiz iz great. 1,164,835 Mariah Thomas 02/0%2011 08:59:44 PN GMT

To view an object's attachment:

1. Go to the Attachments & References section of an object and click the attachment filename.
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5.

From the File Download window choose whether you would like to open or save the attachment.

If you choose to save the file, pick a location locally on your computer to save the file and then
click Open.

After you click Open the file opens and you can view the content. You can open the file using a
native application or save it to your hard drive.

Clicking &9 Jaunches the viewer to see the attachment file directly.

Important If the necessary AutoVue has not been installed or is experiencing its own application

errors, then you cannot successfully view your attachments in a browser. For more
information, see Establishing System Settings and refer to the CNM Implementation
Guide for specific AutoVue information.

Adding Attachments

For more information about the availability of adding attachments, the required settings, and the
Agile PLM file folder subclass relationship to CNM attachments, see Establishing System Settings.

Important Itis necessary for a file server (Agile PLM or UCM) to be installed and configured

outside of CNM in order to upload and retrieve file attachments in CNM. If this has not
been performed properly prior to adding attachments, you will not be able to add
attachments because the Add File option is disabled. For more information, see
Establishing System Settings and refer to the CNM Implementation Guide for specific
file server information.

To add an attachment file:

1.

2.

7.

Go to the Attachments & References section of an object and click + .

& y
From the list menu choose DO File |

In the Add File window click to choose a file to upload.

In the Choose File window navigate to the location of your file, select the file to attach and click
Open.

Enter any desired content in the Description area of the Add File window and when finished click
oK

If you click and select a file that is already an attachment, CNM displays a
Confirmation window that prompts, "File <attachment> already exists on <object>. Please
confirm to overwrite."

Cancel

Click 2K to confirm, or click to not overwrite the file.

Note Ifthe Agile PLM file server is used and the user has the necessary privileges, when the

user adds a file attachment to a CNM object, then a corresponding File Folder object is
created in Agile PLM and the file is added to the Files tab of the File Folder.
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To add an attachment URL:
1. Go to the Attachments & References section of an object and click + .

From the list menu choose ‘& URL
In the Add URL window enter text into the URL field and any desired content into the Description
field.

4. Click 9% to finish.

If you add a URL that is already on an object, CNM automatically overwrites the previous entry and
displays that URL as the latest entry for attachments.

Note If Agile PLM is the selected file server, then to work with attachments in CNM, a user
needs to have the proper file folder privileges in Agile PLM. See the Agile PLM
Administrator Guide.

Removing Attachments

To remove an object's attachment:

XK

1. Go to the Attachments & References section of an object and click next to the attachment or

reference you wish to remove.

2. You are then prompted in a Confirmation window, "Confirm deletion of the <attachment type>:
<filename>."

3. Click 2K to confirm and finish.

If the UCM file server cannot be reached, the attachment is still removed and a message displays
stating that the corresponding file must be removed manually from the UCM file server.

If the Agile PLM file server cannot be reached, the attachment is still removed and a message
displays to the user stating that the corresponding file must be removed manually from the Agile
PLM file server.

If the user does not have the user privileges to delete folders in Agile PLM, the CNM attachment is
still removed and the corresponding folder must be removed manually from Agile PLM.
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Managing Object Teams

When you are viewing an object, there is a collapsible and expandable right-pane Team area where
the currently assigned team members are displayed.

ETeam op 3§ 3 8y

Admin CHKM
Mariah Thomas
MNeal Smith

You can add or remove team members if you have a Participant role or higher. The creator of an
object is always added to the Team list.

If the object type has a configured default value for Team, that default value is displayed in the Team
area. When user groups are deleted by an administrator, they are automatically removed as team
members for objects they were associated with.

Important If you modify the team of an object so that it removes you as a team member —
whether it is specifically removing your user name, or it is removing all user groups
you belong to — once you save that change and navigate away from the object, you
can no longer open that object.

If you try to open that object, you are alerted that your access is denied because you
are not a team member of the object.

If any user with a Participant role or higher removes all the teams from an object, the
object is no longer accessible by any user.

Adding a Team

To add a team member to an object:
1. Open an object.

2. Inthe right pane go to the Team area.
Click T .

In the Add Team window search for a user(s) or user group(s) to add to the object.

5. Select the desired entries and click ﬂ When you have chosen your last selection click

_Apply & Close |\ finish.
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Object Structure Team Association

Team members are also an inherited association between objects. When an object is added to the
structure of another object, the parent object's team is added as a team for the newly added object.

Also, when an object that has a child structure is added to a parent object as its new child object
within an existing structure, any team members from the parent object are associated to all the
children objects of the newly added object.

The example illustrates the business rules of structures and teams.

Create an object QuoteX with a child object ReqY, which also has a child object IdeaZ.

B " QuoteX

..................

Next, add yourself as the only team member of all three objects. In this example your user name is
Mariah Thomas.

Note  You may need to remove any default teams for these objects to be sure that the only
team member is you.

[El Team #x%&

Mariah Thomas

Create a new object QuoteA with a child object RegB, which also has a child object IdeaC.

B " Quotea
=] = ReqB
@i

Add yourself, (Mariah Thomas), as a team member to all three objects and also add a user group,
such as Cats, to all three objects as a team member.

[El Team @x&&

Mariah Thomas
[Cats]

Open QuoteA and click e in the Explorer area to add an object to the structure of object QuoteA.
From the Add Team window choose the object QuoteX that you created earlier, which does not have
the team member Cats.
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The structure of QuoteA now appears like this:

B - QuoteX
= = Reqy
'3 ldeaZ
= & pege
s ldsal

In the Team area of QuoteX, ReqY, and IdeaZ, the user group Cats has automatically been inherited
since it was a team member of the parent object QuoteA.

[El Team #x&&

IMariah Thomas
[Cat=]

Removing a Team

To remove a team member from an object:
1. Open an object.

2. Inthe right pane go to the Team area.

Select the team member(s) you want to remove and click X .

4. A Confirmation window appears:

&> Confirmation [x]

Once the user(z¥user group(s) are removed they can no longer access the object. Do you want to
continug?

| i Continue i Cancel

5. Decide if you want to remove the team member from all the objects in the structure and click

Contiiue | t5 finish.

Caution If you remove yourself, or your user group, you no longer have access to the object,
even though you are performing the action.
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Managing Object Signoffs

Sending an Object for Review

All users with access to an object as a team member can be assigned as an approver of an object,
but a user group cannot be assigned as an approver.

The Approve and Reject buttons are the mechanisms for signoff and are displayed on objects that are
assigned to you as a reviewer. The Approve and Reject buttons display regardless if you have signed
off or not.

Any user with a Participant or higher level of access can send an object for review to a team
member or members.

To send an object for review:
1. Go to the Team area of an object.

2. Select the member(s) you want to review the object.

&

3. Click and in the Send For Review window enter a message for the user(s).

The team member(s) who are assigned a review have a Signoff Pending icon beside their user
name in the Team area; the currently assigned object displays in the My Pending Reviews section of
the Home page for the user(s). Once a user approves or rejects the object, their icon changes
accordingly.

Executing Approvals and Rejections

When a user navigates to an object, information about that user — including any signoff requests or
last approval status — displays at the top of the object. A signoff pending or current review status
icon also appears by the user name in the Team area for that object. This lets a user know that
he/she needs to approve an object or if he/she has completed the review.

To approve an object as an assigned reviewer:

1. Open an object and click . APPf@YE |

2. Inthe Approve window enter your comments into the Comments field.

When you are finished click nARBrOve |

The Notes section of the object now contains the approve action and any accompanying notes
entered along with your approval status and the time stamp you performed the action.

To reject an object as an assigned reviewer:

1. Open an object and click | R&iEet
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2. In the Reject window enter your comments into the Comments field.

When you are finished click =~ R&Eet

The Notes section of the object now contains the reject action and any accompanying notes
entered, along with your rejection status and the timestamp the action was performed.

Once the user approves or rejects the object, an approved or rejected icon displays next to the
user's name in the Team area for that object. Also, a message displays above the Summary section,
alerting the user that he/she approved or rejected the object.

After each signoff, the Team panel is refreshed: the list of users whose signoff has been requested
is sorted by Signoff Action (in order of Pending Signoff, Rejected, and Approved), as well as by
alphabetical order of full name within each Signoff Action.

A user can sign off multiple times for one object, as long as he/she is still an assigned approver,
regardless of what the first signoff status was.

A signoff assignment for a user can be reset by clicking the Reset Signoff 'k button, which
removes any signoff icons next to that user name in the Team area. However, that same user can be
reassigned as a reviewer; once again, the signoff pending icon displays by the user name in the
Team area, and a signoff request alert displays at the top of that object page.

For more information about resetting signoffs, see Resetting Signoffs on page 45.

Users who have been assigned as reviewers, and therefore have correlating status icons for the
review status (Signoff Pending, Approved, and Rejected), are moved to the top of the Team area of
an object.

This grouping of team members is sorted according to signoff status and alphabetical user name
order. The remaining team members who do not have a review assignment status are sorted
alphabetically below.

Resetting Signoffs

If signoffs on an object are no longer required, or when a new set of signoffs is required, then a user
may choose to reset past signoff indications against that object’s team.

To reset signoffs for an object under review:
1. Go to the Team area of an object.

2. Select the member(s) that has/have a current signoff status indicator that you want reset.
Click & .

In the Confirmation window it reads, "You are about to reset the current signoff status for the
selected users. Would you like to continue?" Click 9%

5. The selected member(s) no longer have any review status icons next to their username(s) in
the Team area.

This process also removes the message at the top of the object alerting a user that he/she needs to
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complete a review. However, if the user already completed an action, that information still displays.

Receiving Notifications

Notifications are sent to users when the following actions occur in CNM:

m]

User is notified when he/she is added as a team member for an object in order to perform a
signoff action.

Note  Users that created an object and are therefore team members by default, or are
members of a default team assigned to a type of object by default, are not sent
notifications for being added as a team member at that time.

User is notified when another user sends an object using the Send action.

User who authored a note on an object is notified when a comment is added following that
existing note.

User who is assigned as a reviewer of an object is notified when the assignment is given.

User who assigned reviews is notified when the reviews are completed by each user.
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This chapter includes the following:
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= Refreshing ObJECES IN EXPIOIET ... 56

Introduction to CNM Structures

Structures are the main way to organize different kinds of content around Ideas, Quotes, and
Requirements.

o Ideas may be captured from many sources — including ERP and other external systems — and a
new idea can be linked to earlier ideas for comparison.

@ Quotes and Pricing information can be sought, compared, and used as a basis for advancing or
restraining an idea.

o Requirements can be established; as requirements mature, they can be assigned or distributed
over multiple product releases.

o Comments and other input can be requested from team members that apply to any level of a
structure.

o Finally, mature CNM structures — usually requirements — can be promoted to the product record in
Product Collaboration.

This chapter looks more closely at the mechanics of structure-building.
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Using Explorer to Build Structures

When you are viewing an object there is a collapsible and expandable left pane Explorer area.

Explorer
4+ X = @

Q idea7
Q ldead
E ':' ldead
2 ¥ quotes
= ¥ E Regs
G ldeas
= ¥ El pegp
¥ deac
G lean
=RE] Reqgy’
G dear

Note By default, a user sees the structure of an object with its child objects expanded to only

one level.

The Explorer area has the following actions available:

= Create — add an object to the current structure by creating a new object

= Add — add an object to the current structure by searching for an object

@ Remove — remove an object from the current structure

o View — view the object attribute details for every object within the multi-level object structure in

a table format

o Refresh — refresh all levels of the object structure and collapse the child levels

Note  You may want to refer back to Replicating Structure with Save As on page 29.

All object types can be a part of an Explorer structure. From the Explorer structure you see the status
of each parent and child object giving you an overall perspective of the progress of each element
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within an entire project hierarchy. The icons associated with object status can each be unique and
controlled by the administrator from the Administration section. For more information, please see
Status List on page 78.

Like the search results restrictions, if you do not have access to an object because you are not a
team member, the object does not appear in the Explorer structure. If you select a child object from
the Explorer structure, the child object's Summary section opens, but the Explorer pane still provides
the structure of the initially open parent object. As objects are added, removed, or rearranged, the
Explorer structure will update the arrangement of child objects alphabetically.

Creating New Objects from Explorer

To create a new object from the Explorer menu:

1. Inthe Explorer structure of an object, select the object you want to create your new object
under.

From the Explorer menu click .

3. The Create window appears. Choose the object type from the Type dropdown list and enter a
name in the Name field.

Click 9% to finish that object creation process.
You can continue to create more objects that are automatically added to the Explorer object
structure, or click - “®%% o finish.

The creation process can continue seamlessly by clicking Enter on your keyboard after each
creation. Once the Create window is open, you can navigate to different object structure levels of
parent and child objects in the background and return to the Create window to continue creating
objects to add to the structure level that you navigated to.

As you create (or add) objects that become child objects in a structure, the team of the parent
object is added to all the child objects automatically, so that you now have access to all the child
objects created (or added). For more information, see Object Structure Team Association on page
41.

Viewing an Object Structure

A user can right-click on an object within a structure to bring up a menu for collapsing and
expanding the structure.

[ﬁ Paste

Collapse
Expand All Below
Collapse All Below

v1.2 49



Customer Needs Management User and Administration Guide

If an object is currently only displaying the top level object, the menu has Expand and Expand All
Below options. If an object is currently expanded to all levels, the menu has Collapse and Collapse All
Below options. If the object structure is only expanded to a certain level with child objects still hidden
as collapsed objects, the menu still has the Collapse, Expand All Below, and Collapse All Below options.

For more information about the Paste function, see Search Results.

Adding an Object to a Structure

To add an object to a structure:

1. Inthe Explorer structure of an object, select the object you want to add your object under.

From the Explorer menu click T .

3. Inthe Add Structure window select the type of object you are searching for, enter your search
text string, and click @.

4. From the Search Results table select the object you want to add and drag it to the object
structure level you want, or click 9% to finish.

Child objects added to a structure are displayed at the level of the structure that was selected and

highlighted before the add action began. If you drag and drop an object(s), you can determine which

object in the structure you would like to be the parent object, regardless of what was previously
highlighted.

From any search results in CNM a user can right-click a row or cell and access a Copy function. This
copies the currently selected object to an internal CNM clipboard. A user can now navigate to a
structure of an object in the Explorer area and paste the copied object as an addition to the structure.

To paste an object into a structure:

1. From a Search Result table, highlight the row(s) you want to copy and right-click.

2. Click Copy.
3. Inthe Explorer structure of an object, select the object you want to add your copied object(s)
under.

4. Right-click and select Paste.

For more information about the right-click menu in the Explorer, see Viewing an Object Structure on
page 49.

Object Structure Duplication and Recursion

The rules governing the structure of an object provide a way to prevent unnecessary duplication
and recursion of objects. CNM does not allow repeated objects at the same structure hierarchy level
of an object. To illustrate this behavior, see the example below.
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Open an object that has child objects, such as ProdX. Expand the object structure and see its child
object IdeaQ. Be sure to still have ProdX selected and highlighted.

= Fo)=:| Reqi
Q idea?
EY lgeas
= ':' ldead
2 ¥ quotes
= vE Regs
¥ ldeas
= [ Reqh
@ ldeac
VG dean

Click P and search for Reql. Select Reql from the Search Results table and click oK

You are then prompted with, "Adding duplicate child <Reql> is not allowed". Click 0K to confirm
and the action does not take place.

Note  CNM decides if an object is being repeated according the object number. If there are two
or more objects with the same object name, but with different object numbers they can
be placed at the same level in an object structure.

Regardless of whether or not you can currently see parent objects, CNM will not allow parent
objects to become child objects of an already existing child object of its own. The Where Used option
from the More Actions menu will show you whether or not the currently displayed object also has a
parent object that is not shown in the Explorer area, unless you are not a team member of the parent
object. For more information about the Where Used option, see Where Used on page 33. To illustrate
this behavior, see the example below.
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Open an object that has child objects, such as ProdX. Expand the object structure and see its child
object IdeaQ.

= Fo)=:| Reqi
Q idea?
EY lgeas
= ':' ldead
2 ¥ quotes
= vE Regs
¥ ldeas
= [ Reqh
@ ldeac
VG dean

Click IdeaQ, then click - and search for RegB. Select RegB from the Search Results table and
click 9K

You are then prompted with, "Recursion found for adding object <ReqB>, action denied." Click 1.9
to confirm and the action does not take place.

Rearranging an Object Structure

You can rearrange the structure of an object by dragging and dropping child objects from one level
to another.

Note  The ability to drag and drop an object is available as long as the entire object name is
visible. If the name is cut off, extend the left pane or rename the object.

Objects may be selected and dragged one at a time. As the pointer is dragged through the
structure, a highlight is shown on each object as it is passed over to indicate that object will become
the new parent object if you drop your selection there. To illustrate this behavior, see the example
below.
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Open an object that has child objects, such as ProdX. Select one of its child objects, such as Idea9.

Explorer
+ X B @

B B prodx
= BEA Req1
Eal 9 igear
Q Idead
= BV ideag
2 ¥ prog
=4 @ Reqs
g Ideas
=R B ReqB
4l Ideal
¥ dean

Now drag Idea9 to another child object, RegB, and see that the RegB object is highlighted.

= B prodx
=] o) 2| Redi
&l 1gear

Q Ideas
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Once the RegB object is highlighted, drop Idea9 and it becomes the child object of ReqB.

= B prodx
El Fo] == Reqgi
Q ldea?
Q Idead
=2 ¥ [ Regp
= E Vg
= ¥ Prods
= v B Regs
¥ ldeas
¥ deac
¥ dea

Removing an Object from a Structure

Removing an object from another object’s structure does not cause the child object to be deleted
from the CNM application. Instead, the branch/es underneath become branch/es of the "next-level-
up" object, making it the new parent object and focus then moves to that object.

To remove an object from a structure:
1. Open an object that has a structure.

2. Click the child object you want to remove.

3. Click x to finish.

Structure Table View

The Structure Table View is a way to see the object attribute details for every object within a multi-
level object structure.

Note By default, a user sees the structure view of an object with its child objects expanded to
only one level.

To view the Structure Table of an object:
1. Open an object that has a structure.
Click =

3. The Structure Table View page appears. Expand all the levels of the parent object to see every
object's attributes.

4. Click | 28 {5 finish.
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The
orde

Ed

Structure Table is configurable because a user can drag and drop columns into the desired
r. For more information about reordering columns, see Table Column Reorder.

iting Object Attributes in Structure View

Once a user clicks View and is brought to the structure view page of an object, the user can edit
attributes of objects directly from the table display. Only users with privileges to modify objects can
edit object attributes in the structure view. The editable attributes include all flex fields except the

Rich

Text field.

xyz123

Save Save and Close
"q'T‘_.rpe Deszcription Tags Object Number Status Created By Textl1 Text0:
Name L Type Dezcription Tags Object Number Status Created By textl1 Text0:
@T}rpe De=cription Tags Object Number Status Created By Group
= E"Q"xyz‘IZS ldea IDEAD1042 Pending Admin CNK
= EQm ldea IDEADO3SD Pending Admin CNM
= E"Q"x‘l ldea IDEADZ325 Pending Admin CNK
G |idea This is awesome | || good IDEANZ326 AA Approved x| | Admin CNM
Al Approved
Approved
Approved A&
Canceled

In Progress D
In progress In [IN Progress
Pending
Rejected

To edit object attributes from the structure view page:

1.
2.
3.

Click View.
Click in any cell of an editable attribute.

Once the row of cells becomes editable, enter in the content you want to add or change or
select values from available dropdown menus.

. Save
Click or Save and Cloze

Cancel

to apply your changes to all affected object attributes. Click

to remove all your entered changes and return to the object tab.
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Changes In Process

As changes are made to row cells, a yellow highlight indicator alerts the user that a change was
made as the user navigates throughout different cells. Once the changes are saved, the yellow
highlight indicator disappears and the cells return to their normal state.

Dezcription Tags
Thiz iz great
| need this

new

Update Conflicts

It is possible that in the Structure View of an object there is an object that occurs twice, under two
different parent objects. Because this is possible, it is also possible that a user may make a change
in one instance of the object and enter a conflicting change to the same object elsewhere. CNM will
only apply one change for that object's attribute and there is no way for the user to know which
change will be accepted.

If there is an error in any of the object attributes edited, the Save operation will fail for all changes
made and the user is notified which row cell needs correction before all the changes are saved. The
user can navigate easily to the row cells that need correction as they are marked in red. Then the
user can proceed to save their changes successfully.

Refreshing Objects in Explorer

Clicking Refresh @ reloads the latest changes of an object's structure to reflect the most current
information. If another user is making changes that you need to know about, the refresh feature
makes it possible for you to know what changes have been applied.

To illustrate the Refresh behavior, see the example below.

Open an object that has child objects, such as ProdX. Expand multiple child object levels of ProdX.
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:‘:j-HEElT
'v'ldeaﬂ
= :otk:leaﬁ
= ¥ Quotes
=R @ Reqs
V'ﬁ'ldeas
=R @ Reqh
¥ deac
#:otk:leaﬂ

Make changes to the first level child object, Reql, and save your changes.

Another user, UserB, in another session modifies ProdX by removing the child object Reql from the

structure entirely.

Now click L
now Reql is no longer a child object of ProdX.

Explorer

& 4 X H @

....................

and see that the child objects of ProdX collapse up to the first child object level and
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Exporting and Importing Objects

This chapter includes the following:

B OVBIVIBW ..ottt 59

= Supported Operations and File FOMALS..........covriirics e 59

= Exporting ODJECES fIOM CNM ..o 60

= IMpOrting ODBJECES INTO CNM........iieiiii i 65
Overview

CNM's Export and Import features support the following operations:

o Export an individual object, or an object with structure from object structures to a Microsoft
Excel or aXML file

= Export from search results to a Microsoft Excel file
= Import to update existing objects in the system (CNM server) in the Microsoft Excel format

o Create objects by using the Import process to import directly from Microsoft Excel worksheets

Using these features, you can update existing objects such as Quotes with data provided by one or
more users, or import externally prepared worksheets for use in the CNM application. For example,
there is usually a need to update costs for existing objects, or create costs for new ones. A
convenient option is to export existing data (Quote) pertaining to the object to Excel, update it in the
Excel format, and then import it back into the CNM application. Or, if there is an externally prepared
Excel worksheet with applicable data, you can import the data and use it as a CNM object.

The supported file formats, along with the necessary procedures, constraints, and examples to
perform these tasks appear in this chapter.

Supported Operations and File Formats

o Export supports Microsoft Excel and aXML formats as follows:

*  Excel worksheets — You can export single or multilevel structures, including those from
search results to an Excel worksheet

* aXML files — You can export Attachments (files, URLs, and References to Agile PLM
objects) plus Comments, and Where Used and Structure information from CNM to aXML
files.

= Import only supports the Excel format. You can import a plain list of objects from the following
sources into the system:

* An Excel worksheet from a third-party system as a flat structure
* Exported objects from the object’s tree and search results as a flat list of objects from an
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Excel worksheet

Note  When importing objects, Comments, Attachments, References, and Structure
information are not imported and the "Level" column created during the Export
process is not imported.

Exporting Objects from CNM

You can export from:
o Object structures to Microsoft Excel worksheets
o Object structures to aXML files

o Search results to Microsoft Excel worksheets

Exporting to Microsoft Excel

Exporting to Microsoft Excel from Object Structures or from Search Results prepares a
spreadsheet. However, the Level column is not exported if you are exporting from Search Results
or from Object Structures and you have selected the Root Only option.

Note  When exporting to Microsoft Excel, only the Cover Page fields (out-of-the-box and
flex fields that are enabled) are exported. Attachments, Notes, and Comments are
not exported.

Exporting from Object Structures

Exporting from Object Structures prepares a Microsoft Excel spreadsheet with the following
formation:

o Objects are listed in the sequence in which they appear in the structure tree

o A“Level” field in the first column indicates the hierarchy of the structure, with "0" indicating root
or the object that is exported, and subsequent increments of 1", "2", ... "n" representing the 1%,
2" .., and n" level respectively

o All system attributes and enabled flex attributes are exported as columns under column
headings pertaining to the attribute type

To export objects to Microsoft Excel:

1. Loginto CNM and create an Idea object called Modern Sailboat and a child Quote object
Quote for Modern Sailboat.

Note  The Idea object called Modern Sailboat and the Quote object, Quote for Modern
Sailboat, are created as examples to help document exporting from object
structures. You can open and export an existing object structure as in this example,
or create and export a new object structure. If the object was already added to
Favorites, you can also use Favorites for finding and opening the object that you want
to export. See Exporting to aXML Files.
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2. Inthe More Actions dropdown list, select Export.

ORACLE Agile Customer Needs Management me Admin CN
Create Favortes  Recents  Tools search [NTNGS |
Home Browse Modern Sailboat
Explorer Modern Sailboat
@ X = @ o summary

= = iodem Saiiboat

= Modern Sailboat [E Pending
=B Quote for Modern Sailg

More Details

[ Attachments & References
There ie no data to display.

[l Notes

-

The Export window opens and prompts you to select your choice of Export Format and Export
Level. The Include Attachments option in not available because export to Excel is selected.

3. In Export Format, select Excel, in Export Level, select All Levels, and then press Export.
"Export )

Export Format m

Export Level

Include [yg =
Atftachments

Help Export Close

Note In Export Level, you have the option to select Root Only, Level One, or All Levels.
Selecting Root Only will export the Root object, which in this case is the Idea object.
Selecting Level One, will export the next level, which in this case is the Quote object.
Selecting All Levels, will export the Idea, Quote, and applicable levels to Excel.
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4. A window prompts you to open or save the file. You can save the file for modification in Excel
and for subsequent import it into CNM.

File Download x|

Do you want to open or zave this file?

@ j Mame: IDEADO103.x%ls
[H]

Type: Microsoft Office Excel 97-2003 worksheet
From:  scl34037.us.oracle, com

Open Save | Cancel I

|--"‘~I "While files from the Internet can be uzeful, zome files can potentially
a harm wour computer, [ pou do not trust the source, do not open o
= save this file. What's the risk?

Level _|Name Description  Tags Object Number  Type:ldea Status Date Created Da
Level Mame Description  Tags Object Number  Type:Quote  Status Date Created Da
[ Modern Sailboat boat IDEADO103 Idea Pending 2/24/2011 19:32
i Quote for Modern Sailboat QUOTEDD002  Quote Pending 272472011 20:31

Note You can see the "Level" column mentioned in Supported Operations and File
Formats on page 59 in Column A. When you import this file into the system, this
column is not imported.

Exporting from Search Results

This process prepares a worksheet as follows:
@ Search Results are only exported to Microsoft Excel
o Level is not exported when exporting from Search Results

o If no rows are selected in the Search Results table, Export will export all rows, but if one or
more rows are selected, Export will only export the selected rows

= No export window is launched during the export process

o If objects in search results have a structure, Export from search results will only export the root
object

o Exported objects are not listed in the same sequence in which they appear in the Search
Results table

To export from Search Results:

1. Loginto CNM and in the Browse tab run a search for the object Modern Sailboat.
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Search results display in a Search Results table, as seen below. You can select any object in the
table for export. See Searching in CNM on page 13.

Home Browse

ElAdvanced Search
Match & Al any
Type |Equa|tu L” ;I Tag lm
Name/Number/Desc W Modern Saiboat Rich Text lm
Name Im Date Created m @9
Description [Contains =] Date Modified [Equalte =] )
Number Im Created By lm
Search Reset
[=] Search Result
view- & - B
All - Al B [y
Name MNumber Type Description Status Tag Created By Date Created Date Modified
@ Modern Saiboat |IDEACO103 Idea Pending boat Admin CNM (admin)  |02/24/2011 07:32:4...[02/24/2011 08:31:57 PM PST
T Quote for Mode... | QUOTEDD002 |qwote | [Pending | | Admin Chl (adminy |02024/2011 08:31:5..|02/24/2011 08:3157 PM PET

2. Inthe Search Results table, select the idea object named Modern Sailboat and then click the
Export |@ | button.

Similar to Exporting from Object Structures, a window appears and prompts you to open or
save the Excel file. Although this object has a multi-level structure, only the Root object is
exported and the data displayed in this Excel worksheet does not include the Level column that
appeared in Exporting from Object Structures. Also, although only a few fields are displayed in
the Search Results table, the exported Excel file contains all the Cover Page fields (out-of-the-
box and enabled flex fields).

MName _|Descripti0n Tags Object Number Type:ldea Status Date Created Date Modified Created By Modified By
Madern Sailboat boat IDEAQ0103 ldea Pending 2/24/2011 19:32 2/24/2011 20:31 Adrnin CNM - Admin CNIM

Exporting to aXML files

The following procedure assumes a multi-level Object Structure is already created and added to
Favorites. It locates and opens the object and exports the entire structure (Notes, Comments, and
Attachments and References) to an aXML file.

To export object to aXML files:

1. In CNM Explorer, select Favorites > Proposal for Magnetic Field in... to locate and open the object.

Recents Tools

lManage Faverites...

Launch

! Proposal for Magnetic Field In...

Note  The selected object has References, URLS, Notes and Comments.
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4.

5.

In the More Actions dropdown list, select Export. The Export window opens.

Export 3]

Export Format | qupl  w
Export Level | ol Levels

Include Attachmerts [

Help Export Close

In Export window's Export Format, Export Level, and Include Attachments, select the aXML, All Levels,
and Yes options respectively, and then press Export.

The object along with its References, URLS, Notes, Comments, and Where Used information is
exported in a .ZIP file and the browser gives you the option to save or open the .ZIP file.

File Download x|

Do you want to open or zave this file?

@ Mame: QUOTEODDC zip
Tupe: zip Archive

From: scl34037.us oracle.com

Open Save | Cancel I

harm yaur cormputer. If pou da not trust the source, da nat open or

l--"gJH while files from the Internet can be useful, some files can potentially
N zave this file. What's the risk?

Save and then extract the contents of the .ZIP file.
The aXML file and attachments (files) are included in the .ZIP file.
Open the aXML file.
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Information related to the object such as References, URLS, Notes, Comments, and updates
appear in the aXML file.

<?xml version="1.0" encoding="UTF-8" 7=
- <Objects xmins="http:/ /www.oracle.com/technology/products/applications/xml/plm/2011/04/" zmins:xsi="http:/ /www.w3.org/2001/XMLSchema-ins
xmins:xsd="http://www.w3.0rg/2001/XMLSchema" xsi:schemalLocation="http://www.oracle.com/technology/products/applications/xml/plm/2011/0
http:/ /www.oracle.com/technology/products/applications/xml/plm/2011/04/acnm.xsd">
- «<0Object type="Quote"=
- <Attributes>
<ShortDesc>Proposal for Magnetic Field in...</ShortDesc>
<Tags>magnet</Tags>
<IdeaNumber>QUOTED0004 </IdeaNumberz
<Type=Quote</Type
<Status=Pending</Status=
<DateCreated=2011-02-24T20:59:49-0800</DateCreated >
<DateModified>2011-02-24T21:03:55-0800 </DateModified>
<CreatedBy=Admin CNM </CreatedBy =
<ModifiedBy =Admin CNM </MaodifiedBy >
</Attributes=
- <Reference>
- <Rowz
<Fulfillment=0</Fulfilment=
<Objectkey>2_-1_10000_6099226</0bjectkey>
<Fileld=0=/Fileld>
<DateModified>2011-02-24T21:01:38-0800</DateModified=
<ModifiedBy >Admin CNM </ModifiedBy >
<Sourceld=2</Sourceld=
<RefDesc=Grace 10/25 - - new database on scl34060 demo931oas, demo931rmwowner, demo931rmwuser - add attachment and view work fine-
<RefMumber=P00001 </RefNumber:
<Parentld>10294</Parentld>
<Refld>10307 </Refld>
<Type=Item</Type>
</Row =
- <Rowz
<Fulfillment=0</Fulfilment=
=0bjectkey =http:/ /www.bestever.com</0Objectkey =
<Fileld=0</Fileld>
<DateModified=2011-02-24T21:00:25-0800=/DateModified =
<ModifiedBy >Admin CNM </ModifiedBy >
<Sourceld=-1</Sourceld>
<RefNumber=http:/ fwww.bestever.com</Refilumber=
<Parentld=10294=/Parentld=
<Refld>10300 </Refld=>
<Type=URL=/Typex
</Row =

Importing Objects into CNM

As mentioned in Supported Operations and File Formats on page 59, in addition to importing
exported objects, you can also import a number of objects directly into CNM from Microsoft Excel
worksheets.

Information provided in the following paragraphs lists the importable and modifiable attributes and
those that are neither importable/modifiable and shows how to:

Modify and import an exported CNM object

Import objects that do not exist in the system from an Microsoft Excel worksheet

Modifying Attribute Values

You can modify and update values for all attributes except for the read-only (system) attributes.

You cannot update the following fields using Import:

Object Number
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o Type

o Owner

@ Date Created
o Date Modified
o Created By

o Modified By

You can import values for attributes that are not system attributes and are enabled and modifiable
for the specific object type. Make sure column headings are worded exactly as they appear in CNM,
and a column identifying type is present. In these instances, Oracle recommends using a sample
output file as a template. Other out-of-the-box fields on Cover Page and enabled flex fields can be
updated using the Import process. When importing Date fields, the required format for the entry is
the following: MM/DD/YYYY.

Importing Modified Objects

The following Import procedure creates and locates an object that has its Idea, Requirement, and
Quote components. The object is exported to Excel and after some modifications it is imported and
viewed in CNM.

Important If you plan to import a modified exported object, Oracle recommends enabling the
necessary attributes and creating the Idea, Requirement, Quote types in CNM prior to
export. This preparatory task will simplify updating the applicable attributes in the
Excel worksheet.

Create, update, and import a Requirement Type object for an exported Idea object:

1. In CNM, create the following Requirement object for the Modern Sailboat Idea exported in
Exporting to Excel Worksheets.

Save Cancel

* | Reguirement

Reefing main and jit

ElMore Details

Tags: |hoat Estimatsd [ 7000
Cost:

Object REQO1ETS
Humber: I_;‘ 0
Complete:
Type: Requirement -
) . Special | In Boom Reefing
Status: | pending | Comments:
—_— % _ Date 16-Jan-201001:44 PIf
Completion Lreaten:
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2. In CNM, select and export the Requirement for this object and then open the file in Excel.
A B C D E F G H I J K L M N 0 P 0
1 Mame  DescriptiorTags  Object MurTypeRequStatus  Target Cor Mandator Owner  Requireme Estimated % Comple Special CeDate Creat Date Modit Created B Modified By
2 RequirzmeResfng meboat ~ REQQ167€Requirame Pending Oher 000 T In Boom R 16-Jan-20108-Feb-20° Admin CNI Admin CHM
3. Modify the attributes as shown in the bold font faces.
A B C D E F G H \ J K L M N 0 P Q
1 Name  DescriptiorTags  Object NurType:RequStatus  Target Compl Mandato Owner Requireme Estimated % Comple Special CeDate Creat Date Modif Created By Modified By
2 RequiremeReefing meboat ~ REQQ167€RequirsmePending 31012010 Other 7500 25 In Boom R 16-Jan-20108-Feb-20" Admin CHIY Admin CHIV
4. In CNM, select Tools > Import.
Import
* import File | CEmuse
Help Import Cancel
The Import window displaying status, the number of lines and attributes, and any errors it
encountered during the Import process appears. If you press the Back button, the window
reverts to the one shown in Step 4 above, enabling you to re-import, or import another
workshop. As indicated earlier, Import will lose the Level attribute. This is not applicable here
because the object you are importing is a flat structure.
Import
Import Status: Complete
Import lines completed: 1
Import lines skipped: 0
Reguirement attribute Object Number iz read only
Requirement attribute Date Created iz read only
Requirement attribute Date Modified iz read only
Reguirement attribute Created By iz read only
Requirement attribute Modified By iz read only
Back Cloze
5. In CNM, use object number (REQ01676) to locate the updated object.
=l Search Result
o 8 5B
Al - Al
Name Number Type Dezcription Status Tag Created By Date Created
@Raquirement REQO000A1 Requirement Reefing main and jib |Pending boat Admin CNK {admin} 02/24/2011 09:E
vi.2 67



Customer Needs Management User and Administration Guide

6. In CNM, open the object and note the attributes you updated in Excel (Estimated Cost, %
Complete, and Target Completion Date).

Reguirement [Pending]

Reefing main and ji
= More Details

Tags: boat Coszt: 7500
QObject Mumber: REQD1675 Complete: 25

Type: Requirement Special Comi

S om

]

=: In Boom Reefing

Statuz: Pending 4:  18-Jan-2010 01:44 PN

Target Completion Date:  10-Mar-2010 12:00 AN dified;: 08-Feb-2010 03:18 PM

Mandatory: Created By: Admin CHI

Owner: Wodified By: Admin CHR

Importing Directly from Excel Worksheets

This feature of the Import process enables creating objects that do not exist in the system. The
required access levels, mandatory and optional attributes, and the necessary procedures appear in
this section.

Required Access Level (Privileges)

Because importing objects directly into the system creates new objects, only users with a
“Participant” or higher role can perform this operation. This is the same access level required for
users of the Create function.

Required Attribute Values

To import data directly from a Microsoft Excel worksheet, you must specify values for the following
attributes. Otherwise, the object is not imported

o Object Type
o Object Name
o Obiject Status

Note  Because the Import process creates a new object for each row of the Excel
worksheet, it is necessary to provide these values for each row of the Excel
worksheet. See Examples

Optional Attribute Values

When creating objects using Import, you can assign values to any enabled and modifiable field,
such as the Description field. Do not specify a value for the Object Number attribute. The Object Number
value is specified only if you are trying to update an existing object where specifying the Object
Number value is mandatory. CNM's Import process assigns values for the Object Number attribute for
each imported object.
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Note  To facilitate locating objects created using Import in CNM, use values specified in
the Excel file for attributes such as Tag, Name, or other modifiable fields as search

keys.

Examples

The following example describes the process from the initial creation of the Excel worksheet
through specifying the mandatory attribute values, creating objects using Import, and searching and
viewing the imported objects in CNM. The example assumes one of the modifiable fields called

Value is enabled for the Idea object.

Important Depending on the type of objects that you want to import, you must include a different
number of object header rows. For example, if the import file contains the Idea and
Quote object types, then you must add two header rows with the corresponding field
names for Idea and Quote objects. The example below is adding the Requirement

type also.

To create the worksheet and set the mandatory attributes:

1. In an Excel worksheet, do as follows:

*  Type the values shown in rows 1 - 6 of columns A and B to assign the mandatory values
respectively. Set the values shown in the columns C, D, E, and F of rows 1, 2, and 3 (this

is optional).

* Inrows 4, 5, and 6 of columns A and B, specify the values shown below for the mandatory
fields. Set the values shown in the remaining columns C, D, E, and F of rows 4, 5, and 6

(this is optional).

A B C
1 |Type:ldea Mame Description
2 |Type:Requirement Name Description
3 Type:Quote Name Description
4 |ldes Build a boat Multihull racer
5 |Requirement Speed 20 Knots
6 |Quote S stimate S5000K

D
Status
Status
Status

Pending
Pending
Pending

E

Tags
Tags
Tags
Boat
Boat
Boat

Value

Gold Medal

2. In CNM, select Tools > Import > Browse to open the worksheet.

Import

*Import File | C:\Documents and Settings\ftabibza

Help Import

Cancel

3. In Import dialog, select Import.
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The Import dialog displays the import status. Assigned values for the three rows are imported.

Import

Import Status: Complete
Impatt lines completed: 3
Impiatt lines skipped: 0

Ohject type value is empty.

Cloze

In CNM, use Idea object's Name or Description to locate the imported object.

Note In addition to the mandatory attributes, optional values such as Tags, Status, and

"Gold Medal" which was set for the enabled attribute called Value is also imported.

[l Summary /
Build & hoat [Pending]
Muttinull Facer
[ More Details
Tags: boat Listd1:
Chject Mumber: IDEADDGSZ Text (ldea):
Type: ldea Walue: Gold Medal
Status:  Pending Date Created:  16-Feb-201003:52 PM
Approver: Diate Modified:  16-Feb-2010 03:52 P
Created By Admin CHM
hodified By:  Admin G
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Administration

This Appendix includes the following:

CNIM ADMINISITALION ...ttt 71
ObJECtS AN ATIIOUIES ... 73
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CNM Administration

This Customer Needs Management (CNM) Administration section is the primary resource for CNM
administrators. There is information regarding defining CNM objects and their attributes, setting up
users and user groups, and establishing system settings for CNM.

Assume this chapter is specific to the "CNM Administration” module of Agile CNM when not
otherwise specified. "PLM Administrator" refers to the Administrator module of the "core" Agile PLM
system, accessed in Agile Java Client. (As needed, Agile PLM Administrator Guide is a separate
manual on Oracle Technology Network.)

The manuals that document Agile CNM in this product release are:
o CNM Readme

= CNM Implementation Guide (including Installation)

@ CNM User and Administration Guide

@ CNM Web Services Guide

= CNM Security Guide

Administrative Capabilities

Administrators can customize the behavior of each object type using the configurable options
provided for each object type. There is a specific process to create users in CNM. For more
information, see the CNM Implementation Guide. Once a user is created that has the Administrator
role, more users can be created by accessing the Administration section.

After successfully logging in as an administrator user, access the Administration section by clicking
Adminiztration

in the top right corner of the Home Page. You are directed to the Administration section
that has the following:

vi.2 4l



Customer Needs Management User and Administration Guide

= Objects and Attributes — define and manage object types, attributes, and properties

o Lists — define and manage list values

o Users — create, modify, and disable users

o User Groups — create, modify, and delete user groups

o Keyword Library — create and view keywords that associate CNM objects to one another

o System Settings — configure and establish system settings that impact search, attachments,

sending objects, references, and more

Important Agile CNM supports seven languages in addition to English. If the administrator
makes a change in one language, that change needs to be performed in the other
languages as well to ensure that across all language preferences for users there is a
reflection of the same system changes. After any change is made, all administrators
need to login with other language preferences and make the necessary corresponding
changes.

Promoting CNM Objects to Agile Product Record

Users can promote object data from the CNM framework — single CNM objects or multiple-level
Structures — to the product record as Documents. Because the Promote feature requires a certain
amount of administrative setup (settings in CNM and privileges in PLM), this section is dedicated to
that setup.

While it is possible to promote Ideas and Quotes, the Promote feature is intended for the use case
of Requirements deemed ready for actual production. That is why the "out-of-box" defaults permit
Requirements to be promoted. For users to be able to promote Ideas and Quotes, you must enable
the Allow Promote attribute of that CNM class.

The administrative settings for the Promote feature are provided below.
Settings for Promote Capability

These are the settings that you must attend to for users to be enabled to promote CNM objects to
the product record.

Objects and Attributes
Allow Promote (Yes, No)

System Settings
File Server Type: Agile PLM File Server
Document Subclass: Document

There are settings in Agile Product Collaboration that you must also attend to; these include setting
Autonumbering in the Documents class, and user privileges that are discussed below.
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Important If the Documents class in Agile PLM has not been set up for Autonumbering, CNM
does not promote object data to Document objects.

Privileges Required to Promote CNM Objects

To promote a CNM object to a PLM Document, a user must be assigned the Create privilege in
Agile PLM for the Documents class (which covers all objects created in any Document subclass) or
for the specific Document subclass to which the user will be promoting CNM objects.

To work in the integrated CNM—PLM solutions, a user must have Read and Write privileges to
Items, Projects, Prices, and Problem Reports; more specifically, the PageOne > Number (ID):

* Items > Title Block > Number

*  Projects > General Info > Number

® Prices > General Info > Number

®* PSRs > Problem Reports > Cover Page > Number
To promote an object that has a reference to a PLM object, a user must be assigned the Modify
privilege on that PLM Object.Relationship.Name. If a user does not have this privilege, when he

promotes the object to a PLM Document, it will not carry the specific reference to the other PLM
object.

To promote an object with attached files or URLs, a user must be assigned the Get File privilege
and Modify privilege in Agile PLM for the attachments.

When a user promotes a structure, to see the new BOM structure in the PLM object, the BOM tab for
that object's subclass must be set to visible for that user.

Objects and Attributes

From Objects and Attributes, you can define and manage object types along with their properties and
attributes. Each object type can have a different set of attributes. Specific attributes are common to
all object types while others can be modified, enabled, configured, or removed.

Important You cannot delete a default, pre-defined object type. You can only adjust and change
the properties and attributes of the object type to reflect what you require.

This table lists the default Object Types in CNM.

Object Type Prefix Description

Quote QUOTE A vendor's statement of products and services offered to a potential
customer

Idea IDEA A suggestion for a product, process, or service

Requirement REQ A set of conditions or necessary specifications for a product
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You can change the name, prefix, and other attributes of these object types on the Object
Properties tab (see below). Adjust the object type definitions as needed for your company's
business processes and systems.

Defining Object Properties

All of the available properties of an object are editable. You can configure any object type to help
accommodate your business process needs. The following table contains the configurable object

type properties.

Object Data Property Description
Property Type Values

Name Text Idea, Quote, or The configurable object types for CNM
Requirement

Description Text TBD A text string the administrator enters

Enabled List Yes or No Allows or limits the user creating and searching for specific
object types in CNM. If set to No, the associated object type
cannot be searched for or created. This includes quick
searches, advanced searches, adding by search from
Explorer, and Tag cloud searches.

Default Team List TBD User groups that are assigned to an object type and are
therefore automatically assigned as team members for any
object created that is of that object type

Allow Promote List Yes, No Set to Yes to allow this object type's business objects to be
promoted to the product record.

Prefix Text Default: IDEA, A text string the administrator enters that becomes the prefix

QUOTE, REQ for the object number autogenerated by CNM
Class Name Text Idea, Quote, or Not editable: this field identifies the original (default) Object

Requirement

Type when Name and Prefix fields have been modified.

The required fields, which may not be left blank, are designated by an asterisk (*) before the field
name. (You see the asterisk only during Create and Edit operations.)

Editing Object Properties

To edit the properties of an object type:

1. From Objects and Attributes click the Object Type dropdown menu to choose which object type you

want to edit.
Once you have selected the object type click Edt on the Properties tab.

3. Now all the available fields are in edit mode and you can change the fields to the values you
want.

4. Click save when you are finished.
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Object Attributes

The following are the various data types for attributes:

@ Text — contains any valid character from the keyboard

Note

The Display Height property determines if the text attribute is a single line text field or
a multi-line text field. For more information, see Attribute Properties on page 76.

= Number — contains positive or negative numbers, the decimal (.), comma (,) and the hyphen to
indicate a negative number (-) value

@ List — contain values the administrator configures or sets as default values for such attributes

o Date — a date selected from a calendar or entered directly by the user

The default configuration for the attributes of objects is found in the table below:

Attribute Display Modifiable Data Visible Description
Name Name Type

ID ID No Number No A unique identifier autogenerated by the
CNM system

ShortDesc Name Yes Text Yes An identity for the object

Description Description Yes Text Yes More information about an object

Tags Tags Yes Text Yes A keyword identifier to categorize objects
together

IdeaNumber Object No Text Yes An autogenerated number

Number

Type Type Yes List Yes Classifications for each object type
created by the administrator to
accurately reflect the processes in CNM

Status Status Yes List Yes Determined states for objects that reflect
the progress of the objects
implementation. Default values are:
Pending, Review, Approved, and
Rejected

Owner Owner No Number No The user who created the object

Deleted Deleted No Number No -

ObjVersion Obj Version Yes Number No The version number of the object type

Date01- TBD No Date No Administrator determines this attribute

Date15 according to the CNM process needs for
the users

List01-List15 TBD No List No Administrator determines this attribute

according to the CNM process needs for
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Attribute Display Modifiable Data Visible Description
Name Name Type
the users
Number01- TBD No Number No Administrator determines this attribute
Number15 according to the CNM process needs for
the users
Text01- TBD No Text No Administrator determines this attribute
Text15 according to the CNM process needs for
the users
DateCreated Date No Date Yes The date and time the object was
Created created
DateModified Date Yes Date Yes The date and time the object was last
Modified modified
CreatedBy Created By No List Yes The first and last name of the user that
created the object
ModifiedBy Modified By Yes List Yes The first and last name of the user that
last modified the object
RichText Rich Text Yes Rich No Formatted text entered by the user
Text rendered through ADF

Important Only fifteen flex attributes for each data type are allowed for each object type.

Editing Object Attributes

To edit the attributes of an object type:

1. From Objects and Attributes go to the Attributes tab.

2. Inthe table display of available attributes click the attribute you want to edit.

3. Below is the Attribute Properties section where you click 9t and the attribute property fields
become editable.

4. When you are finished click save

Attribute Properties

The available properties for attributes are found in the table below:

Property Available on Attributes Data Type
Attribute ID Date, List, Number, Text Number
Attribute Name Date, List, Number, Text Text
Display Name Date, List, Number, Text Text
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Property Available on Attributes Data Type
Description Date, List, Number, Text Text
Visible Date, List, Number, Text List
Modifiable Date, List, Number, Text List
Data Type Date, List, Number, Text Text
Display Type Date, List, Number, Text List
Display Order Date, List, Number, Text Number
Default Value Date, List, Number, Text Text
Help Text Date, List, Number, Text Text
List Name List List
Display Height Text Text
Lists

From Lists, you can define and manage list values made available on specific object types. Please
note that when you disable some list values on attributes assigned to those lists, the disabled
values display the text (disabled) after the value in the list dropdown. This applies to all lists
including the users list.

List Properties

The following are the properties of lists:

= ID— a unique identifier autogenerated by the CNM system

@ Name — field you can edit to reflect the name of the list being created

o Enabled — dropdown menu of Yes or No options to determine if the created list is enabled

= Description — area available for more details about the created list

o Type — used to designate the type of list as a Text or Image

List Values

The List Values tab is where you add list values to an already existing list entry. The Entry ID number
is autogenerated, but you need to enter names for each list value you create and determine if it is

enabled or disabled.

Creating list values

To create a list value:
1. Go to the List Values tab.
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Click and enter a name for this list item in the Entry Value field.
3. Set the Enabled field to Yes or No.

4. Click 33"&

5. You can click to continue creating entries.

6. Click >2¥&

when you are finished.

Creating Lists

To create a list:

1. From Administration go to Lists and click L3 .
2. Inthe Properties tab enter a Name for the list you are creating.

Note  List names are not case sensitive and must be unique.
3. Set the Enabled field to Yes or No and enter text into the Description field if needed.

4. Click 22 1o finish.

Modifying Lists
To modify the properties of a list:

1. From Lists go to the Properties tab and click |EdE

2. Enterin your new values for the Name, Enabled, and Description editable fields.

3. Click °®“& 1o finish.

To modify the list values of a list:
1. From Lists go to the List Values tab.
2. Inthe Entry Value and Enabled columns make any changes needed.

Re=zet

3. If the changes made are incorrect click to begin making changes again.

4. click %" 1o finish.

Status List

Each object type has a Status list of values associated with it. This Status list is essential in the
management of the lifecycle of an object within CNM. As an administrator you designate the
number of statuses that are active for each object type, the icon associated with each status, the
name of each status, font color of the status title, the creation of additional statuses or the disabling
of a status that is no longer needed.

78 Agile Product Lifecycle Management



Appendix A

To edit Status list properties for a specific object type:
1. Go to Administration > Lists > Status List > Properties tab.
2. Click Edit.

3. Change values for Name, Description, and set the Enabled dropdown to Yes or No. The Type value
is by default an Image.

4. Click Save.

To edit Status list values for a specific object type:

1. Go to Administration > Lists > Status List > List Values tab.

2. You can edit the current values of existing Statuses or click Create.

3. Enter values for the Entry Value and set the Enabled dropdown to Yes or No.
4. Next add an Icon and select a Font Color.

5. Click Save.

Users

From Users, you can configure the following aspects of users in CNM:
o Create and add new users
= Modify user properties such as email, roles, etc.

o Disable existing users

User Properties

The user object in CNM has the following properties:

Property | Modifiable Description

User ID No The user's sign on name. This property is required to be unique for each user.

Note If your CNM system is integrated with an Agile PLM system, the PLM system
validates the User ID (username) so do not change your CNM User ID

(username).
Status Yes A dropdown list with these two options: Enabled or Disabled
First Yes A text field to enter in a user's first name
Name
Last Yes A text field to enter in a user's last name
Name
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Property | Modifiable Description
Email Yes A text field to enter in a user's email address
Role Yes A dropdown list with the following default options: Viewer, Participant or
Administrator
Note If you have configured the Roles to different names, those will appear as the
options for the user properties
Number Yes A dropdown list providing formats for the display of your numbers
Format
Time Yes A dropdown list providing formats for the display of your current time in Hours,
Format Minutes and Seconds
Time Yes A dropdown list providing global selections for your current time zone
Zone
Date Yes A dropdown list providing formats for the display of your current time date in Years,
Format Months and Days
Language | Yes A dropdown list with the following default options:
English, French, German, Japanese, Korean, Russian, Simplified Chinese and
Traditional Chinese
User Roles

User roles provide a level of security in CNM. The role assigned to a user determines the actions
that the user can carry out on accessible objects.

Viewer — can only perform View, Approve, Reject, Add Notes, Add Comments, Send, View
History, View Where Used, and Add to Favorites actions on the objects that he/she has

access to.

Participant — can perform all object transaction actions such as Create, Delete, Modify, Save
As, Send, Comment, Tag, Import, Export, along with all the actions available to the Viewer
role on the objects that he/she has access to. A Participant does not have access to any of
the Administrator features.

Administrator — can perform all the object actions available in the product that he/she has
access to. The Administrator can also perform all the actions defined in the Administration
section such as defining object attributes, adding lists, creating users and user groups, and
establishing system settings.

Adding a User

Once you have gathered information about new users and assessed their access requirements, add
them to the CNM system. The User ID needs to be unique, and if the administrator chooses an
already existing User ID the system will notify the administrator with an error message.
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To create a new user:

1. From Administration choose Users.

Click to open the Create User window.
Type the Username, First Name, and Last Name in the required fields.
Enter a value for the optional field Email.

Choose Viewer, Participant, or Administrator from the dropdown list of available roles.

o g M w D

Click Create. The Settings tab of the newly created user appears in the bottom pane of the
workspace already in Edit mode.

7. You can then adjust the editable fields of Status, First Name, Last Name, Email, and Role.

Note The User ID is an uneditable field.

Save

8. Click to finish.

Editing a User's Properties

To edit a user's properties:
1. From Administration choose Users.
2. Click the User ID of the user you want to edit.
From the Properties tab of the user click ﬂ
You can then adjust the editable fields of Status, First Name, Last Name, Email, and Role.

Note The User ID is an uneditable field.

5. Click 2% to finish.

Disabling a User

To disable a user:

1. From Administration choose Users.

2. Click the User ID of the user you want to disable.
From the Properties tab of the user click |Edt
Change the Status field from Enabled to Disabled.

Save

5. Click to confirm and finish.

When a user is disabled they no longer have access to the CNM application. The team membership
that they have associated to their user is still valid, but if another user is searching for users to add
to a team, to send an object to, or to make part of a user group, CNM does not display the disabled
users in the search results.

If you disable a user that is a member of any user group, CNM notifies you that the user groups the
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user is a member of are removed from that user. However, when you re-enable the user, CNM
notifies you that the user groups previously associated with the user return to the user and he/she is
once again part of the user group membership.

User Groups

From User Groups, you can configure the following aspects of user groups in CNM:
o Create and add new user groups
o Modify user group properties such as name, description, members, etc.

o Delete existing user groups

User Group Properties

The properties of a user group are Name and Description. A name is required and both are editable.

Members

The Members tab of a user group is where you can search for existing CNM users and add them to a
user group.

Adding a User Group
To create a new user group:

1. From Administration choose User Groups.

2. Click . The Create User Group window opens.
3. Enter values for Name and Description.
4. Click Create to finish.

To add members to a user group:

1. Go to the Members tab of the newly created user group found in the bottom pane of the
workspace.

2. Tofind users to add to the user group click L .

3. From the Add Members window search for existing users.
4. Once you have selected the desired user(s) click 444 16 finish.
Editing a User Group's Properties

To edit a user group's properties:
1. From Administration choose User Groups.

2. Click the name of the user group you want to edit.
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3. From the Properties tab of the user group click \Edt.
4. You can then adjust the editable fields of Name and Description.

Save

5.  When you are finished with your changes click

Deleting a User Group

To delete a user group:
1. From Administration choose User Groups.

2. Click the name of the user group you want to delete.

3. Click X . There is a prompt asking you, "Do you want to delete the selected user group?"
4. Click 2% to confirm the deletion.

Once a user group is deleted, the group is also removed as a team for any object that has it
assigned as a team member.

Keyword Library

From the Keyword Library the administrator can create and view keywords that correlate objects to
one another in CNM.

Keyword Entry and Removal

To create a keyword:
1. Go to Administration > Keyword Library.
2. Click Create.

3. Inthe Create New Keyword(s) window enter text for the name(s) you want to create, up to 150
characters. You can enter more than one keyword at a time by clicking Enter on your keyboard
to separate entries.

Note  Any duplicates entered are ignored by CNM. Keywords are displayed how the user
entered them, but they are treated as case insensitive.

4. When finished, click 2K

To delete a keyword:
1. Go to Administration > Keyword Library.
Find the existing keyword you want to remove and click the

2
3. In the Confirmation window it reads, "Do you want to delete the selected keyword?"
4

Click 9K to finish.
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Keyword Generation

The following areas are used to generate keywords for an object when there are no predefined
keywords entered by an administrator in the Keyword Library:

= All the words in the object Name
o All the tags associated with the object

o All the words from Description, if the description is less than 10 words

If there are predefined keywords entered by an administrator in the Keyword Library, then in addition
to the above mentioned three areas, all the words from the following areas are tallied against the
keywords in the Keyword Library:

o Object Name

o Tags

o Description

o All text, rich text and list flex fields

@ Notes and Comments

All the matches will be added to the keywords for an object. This process is illustrated in the
diagram below.
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[ Description J

/ Long Description (more
than 10 words)

Administrator
predefined
Keywords List

J

Consolidation of all Name, Tags, Description, flex text/list fields, Rich Text,
Notes and Comments.

[ Title/Name

Note  Stopwords are excluded from the keyword list and similar object search analysis. For a
list of stopwords as defined by Oracle, see
http://download.oracle.com/docs/cd/B28359 01/text.111/b28304/astopsup.htm#CE
GBGCDF
http://download.oracle.com/docs/cd/B28359 01/text.111/b28304/astopsup.htm#CEGBG
CDF.

Once the keywords of an object are generated, the set of keywords is used to run a Full Text
Search across all the objects in the system. The Full Text Search returns the matching score for all
the objects in CNM. The top five objects with the highest percentages of association display in the
See Also... section of that current object. For more information see Leveraging the See Also....
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System Settings

From System Settings, you can modify the previously configured CNM system settings.

Rezet

If you enter changes that you do not want to keep, click to remove all the unsaved changes

for each setting.

Any changes made to the system settings go into effect for users who log in after those changes
have been applied by the Administrator, and therefore do not reflect in any user sessions that are
concurrently running while the changes are made.

In order to see changes made by the Administrator, users should log out from their current session
and log back in.

Important It is strongly recommended that you restart your application server after making and
saving changes to the System Settings of CNM in order for all the changes to be
implemented.

Establishing System Settings

The following fields are configured for your CNM system settings after installation:

Name Description Modifiable Values

Schema Version Schema Version No 1.2.0.xx

Authentication Authentication Provider No Agile PLM or LDAP

Provider

Mail Server Mail Server Yes http://mail.your-company-name.com

Mail Server Port Mail Server Port Yes 25

Web Client URL Web Client URL Yes http://cnm-link:port/acnm

Search in Attachment Search in Attachment Yes Yes or No

*Viewer URL Viewer URL Yes http://ucm-web-
client:port/virtual/path/idc/isp/autovue/cs
iApplet.jsp

*UCM Administrator UCM Administrator Yes XXXX

*UCM Administrator UCM Administrator Yes bk

Password Password

CNM Home Directory CNM Home Directory Yes XA\boxxx\yyyy\zzzz

Online Help URL Online Help URL Yes http://<upkhost>/agilecnm/hemi/agilecn
m_gateway.html

File Server Type File Server Type No Agile PLM File Server or UCM
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Appendix A

Name Description Modifiable Values

File Folder Subclass File Folder Subclass Yes Dropdown menu of currently enabled
file folder subclass types available in
Agile PLM

Agile PLM Server URL | Agile PLM Server URL No http://your-agile-plm-server:port/virtual-
path

Agile PLM SSO Agile PLM SSO Server Yes http://your-agile-plm-SSO-

Server URL URL server:port/virtual-path/PLMServlet

Note  The fields with an asterisk (*) above are not required and these fields will be uneditable

when the File Server Type is set to Agile PLM because these options are valid only when
the file server type is set to UCM file server.

All of the fields above will have default values, according to prior configuration, once CNM is
properly installed. For more information, see CNM Implementation Guide.

Some significant CNM behaviors are determined by the values of these system settings.

m]

The Mail Server value determines what server host is sending and receiving notifications for
CNM users.

The Web Client URL value is used to add an object reference to a CNM object's Attachment
section. The URL is necessary to create a reverse link from the Agile PLM reference object
back to the CNM object.

The Search in Attachment value determines if the user can search the content of attachments
associated with objects. When the setting is No, searches are limited to include only attachment
names and descriptions.

The Viewer URL value is necessary to be able to render a view of an attachment for a UCM file
server configuration. If this value is set incorrectly or left blank, the user cannot view any
attachment content.

Note  Without this value set, a user can still get attachments by saving them locally and
then opening them in the native application for the attachment.

The File Server Type value informs the administrator which file server type was configured at the
time of installation. The choices of Agile PLM File Server and UCM are available.

The File Folder Subclass value displays the file folder subclasses currently available and enabled
in Agile PLM. This dropdown list is dynamically produced each time you log in for a user
session.

Note If new subclasses are created and enabled in Agile PLM while in a current user
session, click Reset to refresh the CNM System Settings and the new file folder
subclasses are updated.

When the File Folder Subclass property is not defined, the file folder subclasses are deleted or
disabled in Agile PLM, then this property is empty and the action to add an attachment in CNM

vi.2
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is unavailable. It is recommended that the file folder subclass selection you choose for CNM
object attachments be consistent to make it easier to find those file folders and attachments in
Agile PLM.

Note  The File Folder Subclass property is uneditable for UCM configuration.

o The Online Help URL value gives a location for users to be directed to documentation. If you have
purchased a license for User Productivity Kit (UPK) content for CNM, this URL also directs you
to your UPK help topics.

o The Agile PLM SSO Server URL value validates usernames and passwords for logging in to CNM
from Agile PLM when there is an SSO configuration for users.

Note If this value is left blank, CNM will automatically use the Agile PLM Server URL. This
server and URL are the recommended setting for this value.
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